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About Module Packages

All module packages for 3DxSUITE can be found on the 3DxSUITE Customer Page. Below
is a list of available module packages.

• 3DxSUITE Base Package

• 3DxSUITE Components Package

• 3DxSUITE Viewer Package

• 3DxSUITE Editor Package

• 3DxSUITE SmartController Package

• 3DxSUITE SmartController Pro Package

• 3DxSUITE TransServer Package

• 3DxSUITE WorkerNode Package

• 3DxSUITE Daimler Bundle Package

• 3DxSUITE Honda Bundle Package

• 3DxSUITE Module for CADmeister Package

• 3DxSUITE ScenarioEditor Package

• 3DxSUITE Data Package Studio Package

• 3DxSUITE Validation Configurator Package

• 3DxSUITE PDQ Checker Configurator Package


When referring to each package in this document, it will be enclosed in
<>.
(e.g., Sample scripts are included in the <3DxSUITE Base Package>.)

About 3DxSUITE Setting Utility

Commonly used settings in the 3DxSUITE products, such as license server information or
Scenario folder paths, can be set in "3DxSUITE User Common Setting" or "3DxSUITE Local
User Setting". Please refer to "Elysium 3DxSUITE Setting Utility Manual" for details on the
available items.
In this document, "3DxSUITE User Common Setting" and "3DxSUITE Local User Setting"
will be collectively referred to as "3DxSUITE Setting".
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Shortened Names for 3DxSUITE Products

In this document, the 3DxSUITE product names are referred to as follows:

• 3DxSUITE Components → Components

• 3DxSUITE Viewer → Viewer

• 3DxSUITE Editor → Editor

• 3DxSUITE SmartLauncher (Standalone) → SmartLauncher (Standalone)

• 3DxSUITE SmartLauncher (Plug-in) → SmartLauncher (Plug-in)

• 3DxSUITE SmartController → SmartController

• 3DxSUITE SmartController Pro → SmartController Pro

• 3DxSUITE TransServer → TransServer

• 3DxSUITE WorkerNode → WorkerNode

• 3DxSUITE ScenarioEditor → ScenarioEditor

• 3DxSUITE Data Package Studio → Data Package Studio

• 3DxSUITE Validation Configurator → Validation Configurator

• 3DxSUITE PDQ Checker Configurator → PDQ Checker Configurator

• 3DxSUITE Setting Utility → Setting Utility

Installation of EX9.1 Official Version

To install "3DxSUITE EX9.1 Official" version in an environment where "3DxSUITE EX9.1
beta" version released on July 29, 2022 was installed, please perform the following
steps.

1. Uninstall "3DxSUITE EX9.1 beta" version.

2. Run the below file included in "3DxSUITE EX9.1 Official" version with administrator
privileges in order to delete the unnecessary configuration files of "3DxSUITE EX9.1
beta" version.

<3DxSUITE Base Package>\util\Tools\remove_setting_folders.bat

3. Install "3DxSUITE EX9.1 Official" version.
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1. Preface
This document will explain the installation procedures for 3DxSUITE product lineup. 3DxSUITE
consists of multiple products, and installers are also available for each product or feature.
Decide which product to install on which computer based on your intended use, your license,
load distribution, etc.
Please refer to the separate document "Elysium 3DxSUITE Product Overview Manual" for the
overview of each 3DxSUITE product.

1.1. Overview of Front-End Products Installation
Procedures
Based on which Front-End product you are going to use, the following is a summary of steps for
setting up the 3DxSUITE product lineup. For each Front-End product, you will find: which
installer to run, the target computer to run it on, and the order in which to run it. This is just an
overview of the procedure, so please refer to Chapter 2 and beyond for more details.


Please note that it is written here assuming that SmartLauncher is installed at
the same time as installing Components with the integrated installer.

• Viewer
If "Computer A" is the target to install Viewer on, the order to run the installer, the target
computer, and the installer is as follows.

Install
Order

Target Installer

1 Computer A Elysium_3DxSUITE_EX9.1_Viewer.exe

• Editor
Components are required when using Editor. If "Computer A" is the target to install Editor
on, the order to run the installers, the target computer, and the installers are as follows.

Install
Order

Target Installer

1 Computer A Elysium_3DxSUITE_EX9.1_Components.exe

2 Computer A Elysium_3DxSUITE_EX9.1_Editor.exe

• SmartLauncher
SmartLauncher can be installed from the Components integrated installer. If "Computer A"
is the target to install SmartLauncher on, the order to run the installer, the target computer,
and the installer is as follows.
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Install
Order

Target Installer

1 Computer A Elysium_3DxSUITE_EX9.1_Components.exe

• SmartLauncher Plug-in
SmartLauncher Plug-in can be installed from the Components integrated installer. If
"Computer A" is the target to install SmartLauncher Plug-in on, the order to run the installer,
the target computer, and the installer is as follows.

Install
Order

Target Installer

1 Computer A Elysium_3DxSUITE_EX9.1_Components.exe

• SmartController
Components are required when using SmartController. If "Computer A" is the target to
install SmartController on, the order to run the installers, the target computer, and the
installers are as follows.

Install
Order

Target Installer

1 Computer A Elysium_3DxSUITE_EX9.1_Components.exe

2 Computer A Elysium_3DxSUITE_EX9.1_SmartController.exe

• SmartController Pro
When using SmartController Pro, the actual processing is executed in WorkerNode.
Generally, SmartController Pro and WorkerNode can be installed on separate computers. If
"Computer A" is the target to install SmartController Pro on and WorkerNode on "Computer
B", the order to run the installers, the target computers, and the installers are as follows.

Install
Order

Target Installer

1 Computer A Elysium_3DxSUITE_EX9.1_SmartController_Pro.ex
e

2 Computer B Elysium_3DxSUITE_EX9.1_Components.exe

3 Computer B Elysium_3DxSUITE_EX9.1_WorkerNode.exe

• TransServer
When using TransServer, the actual processing is executed in WorkerNode. In addition,
TransServer must be installed on the computer running the server OS, and WorkerNode
must be installed on the computer running the client OS. If "Computer A" is the target to
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install TransServer on and WorkerNode on "Computer B", the order to run the installers, the
target computers, and the installers are as follows.

Install
Order

Target Installer

1 Computer A Elysium_3DxSUITE_EX9.1_TransServer.exe

2 Computer B Elysium_3DxSUITE_EX9.1_Components.exe

3 Computer B Elysium_3DxSUITE_EX9.1_WorkerNode.exe

• Command Line
Components are required for use in Command Line. If "Computer A" is the target to install
Components on, the order to run the installer, the target computer, and the installer is as
follows.

Install
Order

Target Installer

1 Computer A Elysium_3DxSUITE_EX9.1_Components.exe



Please note that "Elysium_3DxSUITE_EX9.1_Components.exe" is an integrated
installer. From this installer, you can install multiple products such as
Adapters and SmartLauncher together by calling the installers located in the
folders of the line-up. In Install Wizard, select the products you need and run
the installation.
Furthermore, to install only the specified Adapters, you can install them by
individually running the installers inside the folders from the line-up. Please
refer to Appendix A, List of 3DxSUITE Installers for information about the
installers.

1.2. Overview of Utility Tool Installation Procedures
"Utility Tool" is a tool for configuring various settings for the 3DxSUITE product lineup. The
settings made by these tools can be saved as a file, which can then be placed on the computer
where Front-End and Components are installed to achieve the intended behavior. Therefore,
Utility Tool itself can be installed on a computer other than the one on which Front-End or
Components are installed.
The following table summarizes the installers for each product included in Utility Tool and the
Front-Ends that you might use together with that product.

Utility Tool Installer Front-End
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3DxSUITE
Scenario Editor

Elysium_3DxSUITE_EX9.1_Scen
arioEditor.exe

• 3DxSUITE SmartLauncher

• 3DxSUITE SmartLauncher Plug-in

• 3DxSUITE SmartController

• 3DxSUITE SmartController Pro

3DxSUITE Data
Package Studio

Elysium_3DxSUITE_EX9.1_Data_
Package_Studio_for_Acrobat_32
bit.exe
Elysium_3DxSUITE_EX9.1_Data_
Package_Studio_for_Acrobat_64
bit.exe

• 3DxSUITE SmartLauncher

• 3DxSUITE SmartLauncher Plug-in

• 3DxSUITE SmartController

• 3DxSUITE SmartController Pro

3DxSUITE
Validation
Configurator

Elysium_3DxSUITE_EX9.1_Valid
ation_Configurator.exe

• 3DxSUITE SmartLauncher

• 3DxSUITE SmartLauncher Plug-in

• 3DxSUITE SmartController

• 3DxSUITE SmartController Pro

3DxSUITE PDQ
Checker
Configurator

(*1) • 3DxSUITE Editor

• 3DxSUITE SmartLauncher

• 3DxSUITE SmartLauncher Plug-in

• 3DxSUITE SmartController

• 3DxSUITE SmartController Pro

• *1: There is no installer for PDQ Checker Configurator. To use it, open
"PDQCheckerSetting_ENG.xls" with Microsoft Excel. "PDQCheckerSetting_ENG.xlsm" is
included in <3DxSUITE PDQ Checker Configurator Package>.

1.3. Procedure to Run Installers for each Expected
Use Case
The following are several examples of possible situations to show you which installer you need
to run and when.

Case 1:
Translate NX to JT with Editor (using NX (Plug-in) Adapter)

[Corresponding use case with former products]
Translate NX to JT using NX import option (Plug-in) for CADdoctor and the standard
CADdoctor
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a. When installing Editor on a computer where NX is installed

◦ Run "Elysium_3DxSUITE_EX9.1_Components.exe" to install Component and
SmartLauncher. Select "Complete" as the setup type, or select the following program
features for "Custom".

▪ Elysium 3DxSUITE EX9.1 NX Adapter

▪ Elysium 3DxSUITE EX9.1 JT Adapter

◦ Run "Elysium_3DxSUITE_EX9.1_Editor.exe" to install Editor.

b. When installing Editor on a different computer other than the one where NX is installed

◦ Run "Elysium_3DxSUITE_EX9.1_Components.exe" on the computer where NX is installed
to install Component and SmartLauncher. Select "Complete" as the setup type, or select
the following program features for "Custom".

▪ Elysium 3DxSUITE EX9.1 NX Adapter

▪ Elysium 3DxSUITE EX9.1 SmartLauncher (NX Plug-in)

◦ Run "Elysium_3DxSUITE_EX9.1_Components.exe" on the computer where Editor will be
installed to install Components. Select "Complete" as the setup type, or select the
following program features for "Custom".

▪ Elysium 3DxSUITE EX9.1 JT Adapter

◦ Run "Elysium_3DxSUITE_EX9.1_Editor.exe" on the computer where Editor will be
installed to install Editor.

Case 2:
Translate Creo Parametric to SOLIDWORKS with SmartLauncher (using Creo
Parametric (Plug-in) Adapter)

[Corresponding use case with former products]
By using Creo Parametric Adapter (Plug-in) in ASFALIS SmartLauncher or
DirectTranslator, translate from Creo Parametric to SOLIDWORKS

a. When both Creo Parametric and SOLIDWORKS are installed on the same computer

◦ Run "Elysium_3DxSUITE_EX9.1_Components.exe" to install Components and
SmartLauncher. Select "Complete" as the setup type, or select the following program
features for "Custom".

▪ Elysium 3DxSUITE EX9.1 Creo Parametric Adapter

▪ Elysium 3DxSUITE EX9.1 SOLIDWORKS Adapter

b. When Creo Parametric and SOLIDWORKS are installed on different computers

◦ Run "Elysium_3DxSUITE_EX9.1_Components.exe" on the computer where Creo
Parametric is installed to install Components and SmartLauncher. Select "Complete" as
the setup type, or select the following program features for "Custom".

▪ Elysium 3DxSUITE EX9.1 Creo Parametric Adapter
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◦ Run "Elysium_3DxSUITE_EX9.1_Components.exe" on the computer where SOLIDWORKS
is installed to install Components and SmartLauncher. Select "Complete" as the setup
type, or select the following program features for "Custom".

▪ Elysium 3DxSUITE EX9.1 SOLIDWORKS Adapter

Case 3:
Export CATIA V5 model with SmartLauncher CAD Plug-in menu for NX (using NX (Plug-
in) Adapter and CATIA V5 (Plug-in) Adapter)

[Corresponding use case with former products]
Use the CAD plug-in menu of CADdoctor Option for NX to export a .drx file, then import
the file into CADdoctor to heal. After healing, export the file and import it to CATIA V5 by
using CAD plug-in menu of CADdoctor Option for CATIA V5.

a. When both NX and CATIA V5 are installed on the same computer

◦ Run "Elysium_3DxSUITE_EX9.1_Components.exe" to install Components and
SmartLauncher. Select "Complete" as the setup type, or select the following program
features for "Custom".

▪ Elysium 3DxSUITE EX9.1 NX Adapter

▪ Elysium 3DxSUITE EX9.1 SmartLauncher (NX Plug-in)

▪ Elysium 3DxSUITE EX9.1 CATIA V5 Adapter

b. When NX and CATIA V5 are installed on different computers

◦ Run "Elysium_3DxSUITE_EX9.1_Components.exe" on the computer where NX is installed
to install Components and SmartLauncher. Select "Complete" as the setup type, or select
the following program features for "Custom".

▪ Elysium 3DxSUITE EX9.1 NX Adapter

▪ Elysium 3DxSUITE EX9.1 SmartLauncher (NX Plug-in)

◦ Run "Elysium_3DxSUITE_EX9.1_Components.exe" on the computer where CATIA V5 is
installed to install Components and SmartLauncher. Select "Complete" as the setup type,
or select the following program features for "Custom".

▪ Elysium 3DxSUITE EX9.1 CATIA V5 Adapter

Case 4:
Perform CAD Validation between CATIA V5 models with SmartController (using CATIA
V5 (Plug-in) Adapter)

[Corresponding use case with former products]
Translate CATIA V5 model to an intermediate file with CATIA V5 Adapter (CAD Plug-in),
and perform CAD Validation with ASFALIS Controller.

• Run "Elysium_3DxSUITE_EX9.1_Components.exe" to install Components. Select "Complete"
as the setup type, or select the following program features for "Custom".
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◦ Elysium 3DxSUITE EX9.1 CATIA V5 Adapter

• Run "Elysium_3DxSUITE_EX9.1_SmartController.exe" to install SmartController.

Case 5:
Simplify the geometry of NX model with SmartController Pro (using NX (Plug-in)
Adapter)

[Corresponding use case with former products]
Use ASFALIS Controller to simplify the NX model imported by NX Adapter and export the
result again by NX Adapter

• Run "Elysium_3DxSUITE_EX9.1_SmartController_Pro.exe" on the computer where you want
to manage the Jobs to install SmartController Pro.

• Run "Elysium_3DxSUITE_EX9.1_Components.exe" on the computer where NX is installed to
install Components. Select "Complete" as the setup type, or select the following program
features for "Custom".

◦ Elysium 3DxSUITE EX9.1 NX Adapter

• Run "Elysium_3DxSUITE_EX9.1_WorkerNode.exe" on the computer where NX is installed to
install WorkerNode.

Case 6:
Translate SOLIDWORKS to CATIA V5 with TransServer (using CATIA V5 (Plug-in)
Adapter)

[Corresponding use case with former products]
Translate SOLIDWORKS to CATIA V5 by using ASFALIS TransServer, SOLIDWORKS
Adapter, and CATIA V5 Adapter (CAD Plug-in)

a. When both SOLIDWORKS and CATIA V5 are installed on the same computer

◦ Run "Elysium_3DxSUITE_EX9.1_TransServer.exe" on the computer where you want to
manage the Jobs to install TransServer.

◦ Run "Elysium_3DxSUITE_EX9.1_Components.exe" on the computer where both
SOLIDWORKS and CATIA V5 are installed to install Components. Select "Complete" as the
setup type, or select the following program features for "Custom".

▪ Elysium 3DxSUITE EX9.1 SOLIDWORKS Adapter

▪ Elysium 3DxSUITE EX9.1 CATIA V5 Adapter

◦ Run "Elysium_3DxSUITE_EX9.1_WorkerNode.exe" on the computer where both
SOLIDWORKS and CATIA V5 are installed to install WorkerNode.

b. When SOLIDWORKS and CATIA V5 are installed on different computers

◦ Run "Elysium_3DxSUITE_EX9.1_TransServer.exe" on the computer where you want to
manage the Jobs to install TransServer.

◦ Run "Elysium_3DxSUITE_EX9.1_Components.exe" on the computer where SOLIDWORKS
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is installed to install Components. Select "Complete" as the setup type, or select the
following program features for "Custom".

▪ Elysium 3DxSUITE EX9.1 SOLIDWORKS Adapter

◦ Run "Elysium_3DxSUITE_EX9.1_WorkerNode.exe" on the computer where SOLIDWORKS
is installed to install WorkerNode.

◦ Run "Elysium_3DxSUITE_EX9.1_Components.exe" on the computer where CATIA V5 is
installed to install Components. Select "Complete" as the setup type, or select the
following program features for "Custom".

▪ Elysium 3DxSUITE EX9.1 CATIA V5 Adapter

◦ Run "Elysium_3DxSUITE_EX9.1_WorkerNode.exe" on the computer where CATIA V5 is
installed to install WorkerNode.

Case 7:
Use CADdoctor Bundle Package

[Corresponding use case with former products]
Use CADdoctor to import / export IGES and STL files

• Run "Elysium_3DxSUITE_EX9.1_Components.exe" to install Components and
SmartLauncher. Select "Complete" as the setup type, or select the following program
features for "Custom".

◦ Elysium 3DxSUITE EX9.1 IGES Adapter

◦ Elysium 3DxSUITE EX9.1 STL Adapter

• Run "Elysium_3DxSUITE_EX9.1_Editor.exe" to install Editor.



• If you have an optional license for CAD translation in addition to
CADdoctor Bundle Package, you should also select the corresponding
Adapter when installing Components.

• Please refer to "3DxSUITE CADdoctor Bundle Package Manual" for more
details on CADdoctor Bundle Package.

Case 8:
Run CATIA V5 to/from JT translation using Daimler Bundle Package

[Corresponding use case with former products]
Translate CATIA V5 to/from JT by using either CATIA V5 to/from JT DirectTranslator or
forDaimlerSupplier Package of ASFALIS

• Run "Elysium_3DxSUITE_EX9.1_Components.exe" to install Components and
SmartLauncher. Select "Complete" as the setup type, or select the following program
features for "Custom".

◦ Elysium 3DxSUITE EX9.1 CATIA V5 Adapter
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◦ Elysium 3DxSUITE EX9.1 SmartLauncher (CATIA V5 Plug-in)

◦ Elysium 3DxSUITE EX9.1 JT Adapter

◦ Elysium 3DxSUITE EX9.1 PLM XML Adapter

• Run "Elysium_3DxSUITE_EX9.1_SmartController.exe" to install SmartController.

• Run "Elysium_3DxSUITE_EX9.1_SmartController_Pro.exe" to install SmartController Pro.

• Run "Elysium_3DxSUITE_EX9.1_WorkerNode.exe" to install WorkerNode.

• Run "Elysium_3DxSUITE_EX9.1_TransServer.exe" to install TransServer.



• As for the installers other than Components, select and execute the
appropriate one based on which Front-End product you will use to run the
process.

• Please refer to "3DxSUITE Daimler Bundle Package Manual" for more
details on the processing method.

1.4. Installation of Sentinel RMS License Manager
3DxSUITE product line is licensed by Thales' Sentinel RMS License Manager. Install Sentinel
RMS License Manager by running the following installer. Please refer to "Sentinel RMS License
Manager Setup & Quick Start Guide" for more details.

• [Sentinel RMS License Manager Installer]
<3DxSUITE Base Package>\license_server\installer\setup.exe

• [Sentinel RMS License Manager Setup & Quick Start Guide]
<3DxSUITE Base Package>\doc\LicenseServer_QuickStartGuide_en.pdf
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

If you run the installer in an environment where an earlier version of Sentinel
RMS License Manager is installed, the following dialog may appear during the
installation. In case this dialog appears, select "Automatically close and attempt
to restart applications." and click [OK].



Sentinel RMS License Manager can be installed on a same computer on which
the 3DxSUITE product is installed, or on a different computer. Please note that
if you are installing on a different computer, make sure that the computer can
communicate with the computer on which the 3DxSUITE product is installed.
Also, Sentinel RMS License Manager only needs to be installed on one
computer in the environment and does not have to be installed on all
computers where the 3DxSUITE products are installed.

1.5. Installation of .NET Framework
Please note that you may need to manually install ".NET Framework" before the installation of
3DxSUITE products depending on your environment.
See below and install it if necessary.

1. .NET Framework 4.0 to under 4.8 are installed
Run the following installer manually to install .NET Framework 4.8 before the installation of
3DxSUITE products.

◦ <3DxSUITE Base Package>\util\Microsoft .NET\Runtime\ndp48-x86-x64-allos-enu.exe

2. .NET Framework 3.* or earlier is installed / .NET Framework is not installed
Skip this process, and start the installation of 3DxSUITE products. .NET Framework 4.8 will
be installed automatically.

3. .NET Framework 4.8 or later is installed
Skip this process, and start the installation of 3DxSUITE products. An appropriate .NET
Framework version is already installed.
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2. Elysium 3DxSUITE Components
Programs that need to be installed in advance

• n/a

2.1. Installation


You need Administrator privileges to install Elysium products. When installing
Components, select whether to install all at once with the integrated installer
or selectively install the Components with individual installers. A summary of
each method is as follows.

• Installation with integrated installer:
When selecting a Component to install, the prerequisite Components are also selected and
automatically installed together. Since the installer is executed only once, installation
requires the least labor hours. Normally, select this method.

• Selective installation with individual installer:
Select and install only the minimum required Components. Because no unrelated
Components are installed, storage space consumption will be minimized. It is also possible
to use the integrated installer for initial setup, and then use selective installation for adding
features later.

The installation procedure for each method is as follows.

2.1.1. Installation with Integrated Installer



• Please note that installation will fail if the installer placed on a network
drive is executed from a command prompt run as an administrator.

◦ Start the command prompt with login user privileges and run the
installer.

◦ Run the installers for the Components by specifying the UNC path.

◦ Copy the installer for the Components to a local drive and then run it.


• When you click [Cancel] while the integrated installer is running, it will not

roll back any installations that have been performed up to that point. If
necessary, uninstall the installed application manually.
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

• When installing Setting Utility, 3DxSUITE SmartLauncher Base, or
SmartLauncher (Plug-in) from the integrated installer, the older version of
the application is uninstalled first. After that, the latest version will be
installed, but if installation fails during the process, Setting Utility,
3DxSUITE SmartLauncher Base, or SmartLauncher (Plug-in) may not be
installed successfully.

• If you install 3DxSUITE EX9.0.5 or 3DxSUITE EX9.0.14 while Setting Utility
or SmartLauncher of 3DxSUITE EX9.1 has been installed, the application
may not work properly. Therefore, please uninstall ALL applications
included in 3DxSUITE EX9.1 before installing 3DxSUITE EX9.0.5 or
3DxSUITE EX9.0.14.

1. Run the installer for Components.

◦ Folder containing the installer: <3DxSUITE Components Package>\

◦ Installer: Elysium_3DxSUITE_EX9.1_Components.exe

2. Select the language for the installation and click [Next]. English and Japanese are available.
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3. The installation start screen is displayed. Click [Next].

4. Read through the license agreement carefully. Select "I accept the terms in the license
agreement" if you agree, and then click [Next]. If you don’t accept, you cannot continue the
installation.
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5. "Set up Elysium License" dialog will appear. Enter Host name and Port number of the
computer on which Sentinel RMS License Manager is installed.

6. "Destination Folder" dialog will appear. To change the destination folder from default
setting, click [Change] and specify the new destination folder. When the setting is finished,
click [Next].
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
Please ensure that the destination folder path consists of ASCII characters
only. If the folder path contains non-ASCII characters, the application may
not work as expected.

7. Select a setup type.


Please note that when selecting "Custom", it may take a while until the next
dialog appears.

When selecting "Custom", select the program features you want to install. The components
to be installed are automatically selected by referring to the license server specified in step
5. Change the selection status as needed and click [Next].
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8. If the following content appears, click [Next].

9. Click [Install] to start the installation.
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10. If Elysium 3DxSUITE Ruby is not installed in the environment, Elysium 3DxSUITE Ruby
installer will start. Follow the steps below to perform the installation. If Elysium 3DxSUITE
Ruby is already installed, skip to the step after installing Elysium 3DxSUITE Ruby.

a. Installation Wizard starts. Click [Next].

b. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.
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c. "Destination Folder" dialog will appear. To change the destination folder from default
setting, click [Change] and specify the new destination folder. When the setting is
finished, click [Next].


Please ensure that the destination folder path consists only of one-byte
alphanumeric characters and several one-byte symbols ("#", "+", "-", "_",
".", "$", "/", ":"). If characters other than these are included in the path,
an error will occur.

d. Click [Install] to start the installation.
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e. When installation is completed, the following dialog will appear. Click [Finish] to end the
installer.

11. If Setting Utility is not installed, the Setting Utility installer will start. Follow the steps below
to perform the installation. If Setting Utility is already installed, skip to the step after
installing Setting Utility.

a. Installation Wizard starts. Click [Next].
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b. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.

c. "Set up Folders" dialog will appear. Change the folder path if necessary, and then click
[Next].
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d. Click [Install] to start the installation.

e. When the installation of Setting Utility is completed, the following dialog will appear.
Click [Finish] to end the installer.

12. Installation of the Components will be executed. Wait for the process to finish.
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
When you click [Cancel] while the integrated installer is running, it will not
roll back any installations that have been performed up to that point. If
necessary, uninstall the installed application manually.

13. When the installation of Components are completed, the following dialog will appear. Select
the required items and click [Finish]. You may need to reboot the OS after exiting the
installation.

◦ Add SmartLauncher to the Windows context menu
If enabled, [Elysium] will be added to the menu that appears when you right-click on a
file in File Explorer, allowing you to translate files and run Scenarios.

◦ Launch a dialog to create a shortcut to SmartLauncher (Plug-in)
If enabled, you can continue with the shortcut settings of SmartLauncher (Plug-in).
Please refer to "3DxSUITE SmartLauncher Manual" for the shortcut settings of
SmartLauncher (Plug-in).

Elysium 3DxSUITE Installation Guide

 © 2022 Elysium Page 24 | 193





When you click [Finish], a dialog may appear asking you to reboot the OS. If
[Yes] is clicked in the dialog before configuring the shortcut, the OS will reboot
immediately so you will not be able to configure the setting at this point.

To configure the shortcut for SmartLauncher Plug-in, be sure to do so before
clicking [Yes] in the dialog prompting you to reboot. Even if [Yes] is clicked
before configuring the shortcut, you can still configure the same setting later
from "3DxSUITE Setting".

2.1.2. Installation by Selecting Components


Usually this procedure is not required when installing with the integrated
installer.

By running the installer located in the folder of the Components installer line-up, you will be
able to select and install the Components you want.

• 3DxSUITE Component Base

◦ Must be installed to run 3DxSUITE products.

• Adapter

◦ Each Adapter can be installed separately. However, 3DxSUITE Component Base must be
installed before installing the Adapter.

Component Base

1. Select the language for the installation and click [OK].
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2. If below dialog is displayed, click [Install] to start the installation. (If required programs are
already installed, this dialog will not appear.)

3. If Elysium 3DxSUITE Ruby is not installed in the environment, Elysium 3DxSUITE Ruby
installer will start. Follow the steps below to perform the installation. If Elysium 3DxSUITE
Ruby is already installed, skip to the step after installing Elysium 3DxSUITE Ruby.

a. Select which language to use when installing, and click [OK].

b. Installation Wizard starts. Click [Next].
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c. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.

d. "Destination Folder" dialog will appear. To change the destination folder from default
setting, click [Change] and specify the new destination folder. When the setting is
finished, click [Next].
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
Please ensure that the destination folder path consists only of one-byte
alphanumeric characters and several one-byte symbols ("#", "+", "-", "_",
".", "$", "/", ":"). If characters other than these are included in the path,
an error will occur.

e. Click [Install] to start the installation.

f. When installation is completed, the following dialog will appear. Click [Finish] to end the
installer.
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4. If Setting Utility is not installed, the Setting Utility installer will start. Follow the steps below
to perform the installation. If Setting Utility is already installed, skip to the step after
installing Setting Utility.

a. Select which language to use when installing, and click [OK].

b. If above dialog is displayed, click [Install] to start the installation. If 3DxSUITE Setting
Utility is already installed, this dialog will not appear.

c. Installation Wizard starts. Click [Next].
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d. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.

e. "Set up Elysium License" dialog will appear. Enter Host name of the computer where you
installed Sentinel RMS License Manager, and if necessary, change Port number. And
then click [Next].
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f. "Set up Folders" dialog will appear. Change the folder path if necessary, and then click
[Next].

g. Click [Install] to start the installation.
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h. When the installation of Setting Utility is completed, the following dialog will appear.
Click [Finish] to close the installer.

i. When a dialog appears prompting you to reboot, then reboot the OS. After the OS has
rebooted, continue with the next step.

5. Install Wizard will appear. Click [Next].

6. Read through the license agreement carefully. Select "I accept the terms in the license
agreement" if you agree, and then click [Next]. If you disagree, you cannot continue the
installation.
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7. "Destination Folder" dialog will appear. To change the destination folder from default
setting, click [Change] and specify the new destination folder. When the setting is finished,
click [Next].


Please ensure that the destination folder path consists of ASCII characters
only. If the folder path contains non-ASCII characters, the application may
not work as expected.

8. Click [Install] to start the installation.
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9. When installation is completed, the following dialog will appear. Click [Finish]. You may
need to reboot the OS after exiting the installation.

Adapter

1. Select the language for the installation and click [OK].

2. Install Wizard will appear. Click [Next].
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3. Read through the license agreement carefully. Select "I accept the terms in the license
agreement" if you agree, and then click [Next]. If you disagree, you cannot continue the
installation.

4. "Destination Folder" dialog will appear. It will be installed in the folder specified in
3DxSUITE Component Base and cannot be changed. Click [Next].
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5. Click [Install] to start the installation.

6. When installation is completed, the following dialog will appear. Click [Finish]. You may
need to reboot the OS after exiting the installation.
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2.1.3. Silent Installation

For integrated installer

Run command prompt as an administrator, and run the installer from the installation package
with arguments to specify options. This will allow you to install Components without any user
interaction.

• Installer of 3DxSUITE Components "Elysium_3DxSUITE_EX9.1_Components.exe" is located in
the following path.

◦ <3DxSUITE Components Package>\

• Command format is as follows:

◦ Full Installation (No line breaks required)

Elysium_3DxSUITE_EX9.1_Components.exe /silent INSTALLDIR=<Any folder path>
ELY_SEC_SERVER=<Host name> ELY_SEC_PORT=<Port number>

◦ Custom Installation (No line breaks required)

Elysium_3DxSUITE_EX9.1_Components.exe /silent INSTALLDIR=<Any folder path>
ELY_SEC_SERVER=<Host name> ELY_SEC_PORT=<Port number>
ISFeatureInstall=<Components to install>

Add more options to customize the installation (Components to install, and settings) for your
needs. Below is a list of options available for this installation.

• INSTALLDIR
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Description Specify the installation folder.

Value Any folder path

Default value Not specified (Empty string)

Note -

• ELY_SEC_SERVER

Description Specify the host name of the license server.

Value Any character string

Default value Not specified (Empty string)

Note -

• ELY_SEC_PORT

Description Specify the port number of the license server.

Value Any number

Default value 5093

Note -

• /debuglog

Description Specify the path of the installer log. If you specify this option, the log
will be written. This option can also be used for non-silent installation.

Value Log file path (Do not insert any space between "/debuglog" and the
path, and enclose the path in double quotation marks.)

Default value Not specified (Empty string)

Note Example of execution is as follows:

Elysium_3DxSUITE_EX9.1_Components.exe /debuglog"C:\temp\components.log"

• ISFeatureInstall

Description Specify which Components / Utility Tool to install.
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Value A string that indicates which Component / Utility Tool to install
(Multiple strings are allowed. Use commas to separate.)

Default value Not specified (Empty string)

Note If this option is not specified, all Components and Utility Tool will be
installed.


The following "SETTING_COMMON_DATA_FOLDER", "SETTING_CATEGORY",
and "SETTING_SL_DATA_FOLDER" become valid parameters only when all
three parameters are set.

• SETTING_COMMON_DATA_FOLDER

Description If a folder is specified with this option, the files (preference.json and
user_environment.bat) in the specified folder will be copied. Specify
where to copy to in the option "SETTING_CATEGORY" below.

Value Any folder path

Default value Not specified (Empty string)

Note -

• SETTING_CATEGORY

Description Specify where to save the copied files to when the above option
"SETTING_COMMON_DATA_FOLDER" is specified.

Value Either "UserCommon" or "LocalUser"

Default value Not specified (Empty string)

Note When UserCommon is specified, the file is saved in:

%PUBLIC%\Documents\Elysium\3DxSUITE\Config\Common

When LocalUser is specified, the file is saved in:

%LOCALAPPDATA%\Elysium\3DxSUITE\Config\Common

• SETTING_SL_DATA_FOLDER

Description The file (sl_preference_v1.json) in the folder specified by this option is
copied to the computer being installed.
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Value Any folder path

Default value Not specified (Empty string)

Note The file is saved in:

%LOCALAPPDATA%\Elysium\3DxSUITE\Config\SmartLauncher

Below strings are used to indicate the Components / Utility Tool. CB and SLB must be
specified. If there is a common configuration string among the Components that you want to
install, you only need to specify that string once. (See command example)

Component / Utility Tool Configuration String

3DxSUITE Component Base CB

3DxSUITE SmartLauncher Base SLB

ScenarioEditor SE

3DEXPERIENCE Adapter DEXP

SmartLauncher (3DEXPERIENCE Plug-in) DEXP,DEX_SL

CATIA V5 (Plug-in) Adapter V5P

SmartLauncher (CATIA V5 Plug-in) V5P,V5_SL

Creo Elements/Direct Adapter CREDP

Creo Parametric (Plug-in) Adapter CRPP

SmartLauncher (Creo Parametric Plug-in) CRPP,CRP_SL

Inventor Adapter AIP

NX (Plug-in) Adapter NXP

SmartLauncher (NX Plug-in) NXP,NX_SL

NX I-deas Adapter IDEP

SOLIDWORKS Adapter SWP

SmartLauncher (SOLIDWORKS Plug-in) SWP,SW_SL

3D PDF Adapter PDFS

3DXML Adapter XMLS
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Component / Utility Tool Configuration String

ACIS Adapter ACISS

CADmeister Adapter CDMS

CATIA V4 Adapter V4S

CATIA V5 (Standalone) Adapter V5S

Creo Parametric(Standalone) Adapter CRPS

Creo View Adapter CVS

iCAD Adapter ICADS

IGES Adapter IGESS

JT Adapter JTS

Nastran Adapter NSTRS

NX (Standalone) Adapter NXS

OBJ Adapter OBJS

Parasolid Adapter PARS

PLM XML Adapter PLXMS

PointCloud Adapter POCLS

QIF Adapter QIFS

Solid Edge Adapter SEP

STEP Adapter STPS

STEP BOM Adapter STPBS

STL Adapter STLS

VRML Adapter VRMLS

XPDMXML Adapter XPDXMS

XVL Adapter XVLS

Sample Commands:

• Full Installation (No line breaks required)
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Elysium_3DxSUITE_EX9.1_Components.exe /silent INSTALLDIR="C:\\Program
Files\\Elysium\\Components" ELY_SEC_SERVER=Sever ELY_SEC_PORT=5093

• Custom Installation (No line breaks required)

Elysium_3DxSUITE_EX9.1_Components.exe /silent INSTALLDIR="C:\\Program
Files\\Elysium\\Components" ELY_SEC_SERVER=Sever ELY_SEC_PORT=5093
ISFeatureInstall=CB,SLB,V5P,V5_SL,STPS

For individual Component installer

Run command prompt as an administrator, and run the installer from the installation package
with arguments to specify options. This will allow you to install each Component without any
user interaction.

• Installer of each Component is located in the following path:

◦ <3DxSUITE Components Package>\<Component Name>

• Below is an example of a command. In the example, 3D PDF Adapter is used, but the same
applies to other Components as well.

Elysium_3DxSUITE_EX9.1_3D_PDF_Adapter.exe /s /v"/l* \"C:\temp\install.log\" /qn"

This is a list of command arguments to pass to the installer when executing silent installation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional


Please note that your OS may reboot after you have executed and completed
the silent installation with "3DxSUITE Component Base" installer.

Elysium 3DxSUITE Installation Guide

 © 2022 Elysium Page 42 | 193



2.2. Uninstallation

 You need Administrator privileges to uninstall Elysium products.

2.2.1. Manual Uninstallation

For installing with integrated installer

1. From Windows menu, select [Start] > [Settings].

2. Then select [Apps].

3. From the list of applications displayed in "Apps & features", select "Elysium 3DxSUITE EX9.1
- Components" to uninstall.

For installing with individual Component installer


In the below example, 3D PDF Adapter is used, but the same applies to other
Components as well.

1. From Windows menu, select [Start] > [Settings].

2. Then select [Apps].

3. From the list of applications displayed in "Apps & features", select "Elysium 3DxSUITE EX9.1
- 3D PDF Adapter" to uninstall.

2.2.2. Silent Uninstallation

For installing with integrated installer

Run command prompt as an administrator, and run the installer with arguments below. This
will allow you to uninstall Components without any user interaction.

Sample Command:

Elysium_3DxSUITE_EX9.1_Components.exe /silent /remove


The option "/debuglog" can also be specified. Please refer to this for details
about the option.

For installing with individual Component installer

Run command prompt as an administrator, and run the installer with arguments below. This
will allow you to uninstall each Component without any user interaction.

• Below is an example of a command. In the example, 3D PDF Adapter is used, but the same
applies to other Components as well.
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Elysium_3DxSUITE_EX9.1_3D_PDF_Adapter.exe /s /x /v"/l* \"C:\temp\ininstall.log\"
/qn"
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3. Elysium 3DxSUITE Viewer
Programs that need to be installed in advance

• n/a

3.1. Installation

 You need Administrator privileges to install Elysium products.

3.1.1. Manual Installation

1. Run the installer for 3DxSUITE.

◦ Folder containing the installer: <3DxSUITE Viewer Package>\

◦ Installer: Elysium_3DxSUITE_EX9.1_Viewer.exe

2. Select the language for the installation and click [OK].

3. If the dialog below is displayed, click [Install] to start the installation.

◦ If these installers are already installed, this dialog will not appear.

4. If Setting Utility is not installed, the Setting Utility installer will start. Follow the steps below
to perform the installation. If Setting Utility is already installed, skip to the step after
installing Setting Utility.
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a. Select which language to use when installing, and click [OK].

b. If above dialog is displayed, click [Install] to start the installation. If 3DxSUITE Setting
Utility is already installed, this dialog will not appear.

c. Installation Wizard starts. Click [Next].

d. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.
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e. "Set up Elysium License" dialog will appear. Enter Host name of the computer where you
installed Sentinel RMS License Manager, and if necessary, change Port number. And
then click [Next].

f. "Set up Folders" dialog will appear. Change the folder path if necessary, and then click
[Next].
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g. Click [Install] to start the installation.

h. When the installation of Setting Utility is completed, the following dialog will appear.
Click [Finish] to close the installer.
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i. When a dialog appears prompting you to reboot, then reboot the OS. After the OS has
rebooted, continue with the next step.

5. Viewer Install Wizard will appear. Click [Next].

6. Read through the license agreement carefully. Select "I accept the terms in the license
agreement" if you agree, and then click [Next].

7. "Destination Folder" dialog will appear. To change the destination folder from default
setting, click [Change] and specify the new destination folder. When the setting is finished,
click [Next].
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
Please ensure that the destination folder path consists of ASCII characters
only. If the folder path contains non-ASCII characters, the application may
not work as expected.

8. The following dialog will appear. Disable "Create a desktop shortcut" if you do not want to
create a desktop shortcut. Click [Install] to start the installation.

9. When the installation is finished, the following dialog will appear. Click [Finish] to close the
dialog.
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3.1.2. Silent Installation

By using the command, you can install or upgrade Viewer without GUI operations.

• Example of command

Elysium_3DxSUITE_EX9.1_Viewer.exe /s /v"/l* \"C:\temp\install.log\"
INSTALLDIR=\"C:\Program Files\Elysium\3DxSUITE\EX9.1\Viewer\" /qn"

This is a list of command arguments to pass to the installer when executing silent installation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• INSTALLDIR=\"<Installation Folder>\" : Specify the folder
where you want to install. This can be specified only
when installing.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional
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3.2. Launch
In Windows start menu, select [Elysium 3DxSUITE Viewer] > [3DxSUITE Viewer EX9.1] to launch
3DxSUITE Viewer.

3.2.1. Setting License

After the installation, the license settings dialog may appear the first time you start Viewer. This
dialog will not appear the next time you start. Also, this dialog can be opened by selecting [Help]
> [License] after starting Viewer.

Confirm the status of license usage by clicking [License Status].



• If you change the initial value in "License Information" dialog and click
[OK], the license information will be saved as the setting common for all
users using Viewer. So even if you change the license settings from
3DxSUITE Setting later on, the license information in Viewer will not
change.

• If you change the initial value in "License Information" dialog but not
clicking [OK] at all, the license will be obtained by referring to the settings
in 3DxSUITE Setting. In that case, if the license settings in 3DxSUITE Setting
are changed, the license information in Viewer will also change.

3.3. Exit
Select [File] > [Exit] from the menu or close the window to exit.

3.4. Uninstallation
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3.4.1. Manual Uninstallation

1. From Windows start menu, select [Start] > [Settings](Gear mark).

2. Then select [Apps].

3. From the list of applications displayed in "Apps & features", select "Elysium 3DxSUITE EX9.1
- Viewer" to uninstall.

3.4.2. Silent Uninstallation

Silent uninstallation can be performed by a command. Installer of the currently installed
version will be required.

• Example of command

Elysium_3DxSUITE_EX9.1_Viewer.exe /s /x /v"/l* \"C:\temp\uninstall.log\" /qn"

This is a list of command arguments to pass to the installer when executing silent
uninstallation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/x Execute uninstallation. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional
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4. Elysium 3DxSUITE Editor
Programs that need to be installed in advance

• Components

4.1. Installation


You need Administrator privileges to install Elysium products.
If the required program is not installed beforehand, execution will abort.

4.1.1. Manual Installation

1. Run the installer for Editor.

◦ Folder containing the installer: <3DxSUITE Editor Package>\

◦ Installer: Elysium_3DxSUITE_EX9.1_Editor.exe

2. Select the language for the installation and click [OK].

3. If Microsoft Edge WebView2 is not installed, the following screen will appear so click
[Install]. If the software is already installed, proceed to the next step.

4. Editor setup screen will appear. Click [Next].
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5. Read through the license agreement carefully. Select "I accept the terms in the license
agreement" if you agree, and then click [Next]. If you disagree, you cannot continue the
installation.

6. The dialog to specify a destination folder will appear. To change the destination folder from
default setting, click [Change] and specify the new destination folder. When the setting is
finished, click [Next].
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
Please ensure that the destination folder path consists of ASCII characters
only. If the folder path contains non-ASCII characters, the application may
not work as expected.

7. The following dialog will appear. Disable "Create a desktop shortcut" if you do not want to
create a desktop shortcut, and then click [Install] to start the installation.

8. When the installation is completed, the following dialog will appear. Click [Finish].
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4.1.2. Silent Installation

By executing the command, you can install or upgrade Editor without displaying the UI. Please
refer to the following command examples and command argument descriptions for the
executing commands.

• Example of command

Elysium_3DxSUITE_EX9.1_Editor.exe /s /v"/l* \"C:\temp\install.log\"
INSTALLDIR=\"C:\Program Files\Elysium\3DxSUITE\EX9.1\Editor\" /qn"

This is a list of command arguments to pass to the installer when executing silent installation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• INSTALLDIR=\"<Installation Folder>\" : Specify the folder
where you want to install. This can be specified only
when installing.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional
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4.1.3. Installation of CADmeister Add-on

To use CADmeister Add-on, copy CRESTAM folder, which is included in <3DxSUITE Module for
CADmeister Package>, to the root folder of the drive where you installed Components. (Ex:
C:\CRESTAM)



Please note that you cannot use CRESTAM folder for 3DxSUITE EX9.0 or former
version along with Editor EX9.1 and Components EX9.1. Please use CRESTAM

folder for 3DxSUITE EX9.1 when you use Editor EX9.1 and Components EX9.1.

To use multiple version of Editor with CADmeister Importer / Exporter on
one computer, you must install each version of Components on different
drives and place corresponding CRESTAM folder to the root folder of those
drives.

4.2. Launch
From Windows start menu, select [Elysium 3DxSUITE Editor] > [3DxSUITE Editor EX9.1] to
launch Editor.



Before starting Editor for the first time, it is recommended that you launch
3DxSUITE Setting Utility and implement the settings related to the input and
output CADs.

To launch 3DxSUITE Setting Utility, select [Elysium 3DxSUITE] > [3DxSUITE
User Common Setting] or [Elysium 3DxSUITE] > [3DxSUITE Local User Setting]
from Windows Start menu.
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

If you drag-and-drop the following CAD format files into Editor, the Plug-in
Adapter is used by default.

• CATIA V5

• NX

• Creo Parametric

Therefore, if you do not have a license for Plug-in Adapter, a license error will
occur. To ensure that Standalone Adapter is used instead of Plug-in Adapter
when dragging and dropping these CAD format files, enable "Use standalone
adapter" in "3DxSUITE Setting".

4.2.1. Setting License

If "License Client Setting" dialog appears when starting Editor, please ensure that the server
name, port number, and license type (Node Lock / Floating / Commuter) are set correctly;
otherwise, correct them if necessary.
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• Confirm the status of license usage by clicking [License Status].

• Please refer to the separate "Sentinel RMS License Manager Setup & Quick Start Guide" for
more details about License Server. Document path can be found in Chapter 6 of the separate
"Elysium 3DxSUITE: Product Overview Manual".



• If you change the initial value in "License Client Setting" dialog and click
[OK], the license information will be saved as the setting for you only. So
even if you change the license settings from 3DxSUITE Setting later on, the
license information in Editor will not change.

• If you change the initial value in "License Client Setting" dialog but not
clicking [OK] at all, the license will be obtained by referring to the settings
in 3DxSUITE Setting. In that case, if the license settings of 3DxSUITE Setting
are changed, the license information in Editor will also change.

4.3. Exit
Select [File] > [Exit] from the menu.

4.4. Uninstallation

4.4.1. Manual Uninstallation

1. From Windows start menu, select [Settings](Gear mark).

2. Then select [Apps].

3. From the list of applications displayed in "Apps & features", select "Elysium 3DxSUITE EX9.1
- Editor" to uninstall.
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4.4.2. Silent Uninstallation

Below is the command for silent uninstallation. The installer for the version you are currently
using will be required. Please refer to the below command example and command arguments
for details.

• Example of command

Elysium_3DxSUITE_EX9.1_Editor.exe /s /x /v"/l* \"C:\temp\uninstall.log\" /qn"

This is a list of command arguments to pass to the installer when executing silent
uninstallation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/x Execute uninstallation. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional
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5. Elysium 3DxSUITE SmartLauncher
Programs that need to be installed in advance

• n/a

5.1. Installation



Please note that when installing Components by using
"Elysium_3DxSUITE_EX9.1_Components.exe", SmartLauncher will also be

installed at the same time. In this case, you do not need to install
SmartLauncher separately.

The following is the procedure for installing each component and
SmartLauncher separately without using
"Elysium_3DxSUITE_EX9.1_Components.exe".

 You need Administrator privileges to install Elysium products.

5.1.1. Manual Installation of SmartLauncher (Standalone)

1. Run the installer for 3DxSUITE Component Base. If "3DxSUITE Component Base" is already
installed, proceed to the steps to run "Elysium_3DxSUITE_EX9.1_SmartLauncher_Base.exe".

◦ Folder containing the installer: <3DxSUITE Components Package>\Component_Base\

◦ Installer: Elysium_3DxSUITE_EX9.1_Component_Base.exe

2. Select the language for the installation and click [OK]. Japanese and English are available.

3. When this dialog appears, click [Install].
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4. If Elysium 3DxSUITE Ruby is not installed in the environment, Elysium 3DxSUITE Ruby
installer will start. Follow the steps below to perform the installation. If Elysium 3DxSUITE
Ruby is already installed, skip to the step after installing Elysium 3DxSUITE Ruby.

a. Select which language to use when installing, and click [OK].

b. Installation Wizard starts. Click [Next].

c. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.
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d. "Destination Folder" dialog will appear. To change the destination folder from default
setting, click [Change] and specify the new destination folder. When the setting is
finished, click [Next].


Please ensure that the destination folder path consists only of one-byte
alphanumeric characters and several one-byte symbols ("#", "+", "-", "_",
".", "$", "/", ":"). If characters other than these are included in the path,
an error will occur.

e. Click [Install] to start the installation.
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f. When installation is completed, the following dialog will appear. Click [Finish] to end the
installer.

5. If Setting Utility is not installed, the Setting Utility installer will start. Follow the steps below
to perform the installation. If Setting Utility is already installed, skip to the step after
installing Setting Utility.

a. Select which language to use when installing, and click [OK].

b. If above dialog is displayed, click [Install] to start the installation. If 3DxSUITE Setting
Utility is already installed, this dialog will not appear.
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c. Installation Wizard starts. Click [Next].

d. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.
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e. "Set up Elysium License" dialog will appear. Enter Host name of the computer where you
installed Sentinel RMS License Manager, and if necessary, change Port number. And
then click [Next].

f. "Set up Folders" dialog will appear. Change the folder path if necessary, and then click
[Next].

g. Click [Install] to start the installation.
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h. When the installation of Setting Utility is completed, the following dialog will appear.
Click [Finish] to close the installer.

i. When a dialog appears prompting you to reboot, then reboot the OS. After the OS has
rebooted, continue with the next step.

6. Install Wizard of "3DxSUITE Component Base" starts. Click [Next].
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7. Read through the license agreement carefully. Select "I accept the terms in the license
agreement" if you agree, and then click [Next]. If you disagree, you cannot continue the
installation.

8. "Destination Folder" dialog will appear. To change the destination folder from default
setting, click [Change] and specify the new destination folder. When the setting is finished,
click [Next].
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
Please ensure that the destination folder path consists of ASCII characters
only. If the folder path contains non-ASCII characters, the application may
not work as expected.

9. Click [Install] to start installation.

10. The following dialog will appear once the installation is completed. Click [Finish] to exit
installation of "3DxSUITE Component Base".
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11. When a dialog appears prompting you to reboot, then reboot the OS.

12. Next, run the installer for 3DxSUITE SmartLauncher Base.

◦ Folder containing the installer: <3DxSUITE Components Package>\SmartLauncher_Base\

◦ Installer: Elysium_3DxSUITE_EX9.1_SmartLauncher_Base.exe

13. Select the language for the installation and click [OK]. Japanese and English are available.

14. Install Wizard starts. Click [Next].
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15. Read through the license agreement carefully. Select "I accept the terms in the license
agreement" if you agree, and then click [Next]. If you disagree, you cannot continue the
installation.

16. "Destination Folder" dialog will appear. It will be installed in the folder specified in
3DxSUITE Component Base and cannot be changed. Click [Next].
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17. Click [Install] to start installation.

18. The following dialog will appear once the installation is completed. Select the required items
and click [Finish].
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◦ Add SmartLauncher to the Windows context menu
If enabled, SmartLauncher is added to Windows context menu.

◦ Show the Windows Installer log
If enabled, Windows Installer log will appear after the installation is completed.



At this point, you are at a stage where only the foundation of SmartLauncher
has been installed. Next, continue onto the installation of Components that are
required for your desired processing. Components can be installed by running
the installer found in each folder of <3DxSUITE Components Package>. Please
refer to Appendix A, List of 3DxSUITE Installers for more details on each
installer.

5.1.2. Manual Installation of SmartLauncher (Plug-in)



Before installing SmartLauncher (Plug-in), you need to install the
corresponding CAD Adapter, 3DxSUITE Component Base, and 3DxSUITE
SmartLauncher Base beforehand. For example, if you want to install
SmartLauncher (Plug-in) for CATIA V5, install CATIA V5 (Plug-in) Adapter,
3DxSUITE Component Base, and 3DxSUITE SmartLauncher Base beforehand.

1. Run the installer for SmartLauncher (Plug-in). The following procedure is the same for all
CADs. Below example will be explained using the images of SmartLauncher (Plug-in)
installer for CATIA V5.

◦ Folder containing the installer: <3DxSUITE Components Package>\SmartLauncher_***\

◦ Installer: Elysium_3DxSUITE_EX9.1_SmartLauncher_***.exe
(*** describes the CAD name where SmartLauncher (Plug-in) will be installed.)

2. Select the language for the installation and click [OK]. Japanese and English are available.
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3. Install Wizard starts. Click [Next].

4. Read through the license agreement carefully. Select "I accept the terms in the license
agreement" if you agree, and then click [Next]. If you disagree, you cannot continue the
installation.

5. "Destination Folder" dialog will appear. It will be installed in the folder specified in
3DxSUITE Component Base and cannot be changed. Click [Next].
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6. Click [Install] to start installation.

7. The following dialog will appear once the installation is completed. Select the required items
and click [Finish].
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◦ Launch a dialog to create a shortcut to SmartLauncher (Plug-in)
If enabled, the shortcut setting dialog for SmartLauncher Plug-in will appear after the
installation is completed.



When you click [Finish], a dialog may appear asking you to reboot the OS. If
[Yes] is clicked in the dialog before configuring the shortcut, the OS will
reboot immediately so you will not be able to configure the setting at this
point.
To configure the shortcut for SmartLauncher Plug-in, be sure to do so
before clicking [Yes] in the dialog prompting you to reboot. Even if [Yes] is
clicked before configuring the shortcut, you can still configure the same
setting later from "3DxSUITE Setting".

8. When "Launch a dialog to create a shortcut to SmartLauncher (Plug-in)" is enabled, the
following dialog will appear. Enable / disable the checkbox, if necessary, and click [OK].

3DxSUITE SmartLauncher detects CAD systems automatically from the registry, and they
will be listed in the dialog along with their installation folder path. Please note that it may
fail to detect automatically when:

◦ The same CAD version is installed more than once within a single computer
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◦ The registry keeps information of old CAD systems

Environment file to start the CAD system (ENV file for CATIA V5, ENV file for 3DEXPERIENCE,
custom_dirs.dat for NX) can be specified from the setting icon ( ) in the dialog.

Please note that the following checkbox options will be effective for the CAD versions checked
in above dialog only.

• Create shortcuts in Desktop

• Create shortcuts in Program Menu

If you want to change the displayed CAD installation environment, or if the installed CAD
version is not displayed, close the dialog. Then, set it up from 3DxSUITE Setting.

5.1.3. Silent Installation of SmartLauncher (Standalone)

Run command prompt as an administrator, and run the installer from the installation package
with arguments to specify options. This will allow you to install SmartLauncher (Standalone)
without any user interaction.

Sample Command (No line break is required):

Elysium_3DxSUITE_EX9.1_SmartLauncher_Base.exe /s /v"/l* \"C:\temp\install.log\"
/qn"

• Folder containing the installer: <3DxSUITE Components Package>\SmartLauncher_Base\

• Installer: Elysium_3DxSUITE_EX9.1_SmartLauncher_Base.exe

Add more options to customize the installation (Components to install, and settings) for your
needs. Below is a list of options available for this installation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory
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Command
Argument

Description Mandatory /
Optional

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• INSTALLDIR=\"<Installation Folder>\" : Specify the folder
where you want to install. This can be specified only
when installing.

• INSTALL_SHELL_EXTENSION=0/1 : Specify whether to
add the context menu for SmartLauncher. Default value
is 1. (0: Don’t add the context menu for SmartLauncher /
1: Add the context menu for SmartLauncher)

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional

5.1.4. Silent Installation of SmartLauncher (Plug-in)

Run command prompt as an administrator, and run the installer from the installation package
with arguments to specify options. This will allow you to install SmartLauncher (Standalone)
without any user interaction. Specify the executable corresponding to the CAD that will be used
with SmartLauncher (Plug-in).

Sample Command (SmartLauncher (Plug-in) for Creo Parametric):

Elysium_3DxSUITE_EX9.1_SmartLauncher_Creo_Parametric.exe /s /v"/l*
\"C:\temp\install.log\"/qn"

This is a list of command arguments to pass to the installer when executing silent installation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation in silent mode. Mandatory
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Command
Argument

Description Mandatory /
Optional

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• INSTALLDIR=\"<Installation Folder>\" : Specify the folder
where you want to install. This can be specified only
when installing.

• CREATE_ALL_SHORTCUTS=0/1 : Specify whether to create
a desktop shortcut automatically. Default value is 1. (0 :
Don’t create a shortcut / 1 : Create a shortcut)

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional

5.2. Initial Settings for SmartLauncher (Plug-in)
The configuration of SmartLauncher (Plug-in) should be executed with 3DxSUITE Setting. Below
are the procedure.

1. From Windows menu, select [Elysium 3DxSUITE] > [3DxSUITE User Common Setting] or
[Elysium 3DxSUITE] > [3DxSUITE Local User Setting].

2. Open [CAD] tab.
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3. Open the preferred CAD to set, and set the following contents in the version to be used for
translation.

◦ Enable / disable the checkboxes to specify whether the versions should be used for
translation.

◦ Press the Gear icon and a dialog will appear. Set the configuration keyword for
translation. (Optional)

◦ Set the folder path where the CAD executables are located in the "Install directory".

◦ When clicking [Create shortcut to start CAD], you can create a shortcut to launch CAD
with SmartLauncher (Plug-in) embedded. (*1)



*1: Only certain versions of CAD as listed below can launch SmartLauncher
(Plug-in) from the CAD UI. Please refer to "Supported CAD Version" list in
the Release Note for more details about CAD versions where the user can
launch SmartLauncher (Plug-in) from CAD UI.

◦ CATIA V5

◦ 3DEXPERIENCE

◦ Creo Parametric

◦ NX

◦ SOLIDWORKS

[Create shortcut to start CAD…] button will not appear for CAD versions
where the user cannot launch SmartLauncher (Plug-in) from CAD UI. For
those CAD versions, translation can be performed only from the context
menu.
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4. Click [OK] to close the dialog.

5.2.1. Initial Settings for CAD Systems

Please refer to "3DxSUITE_Component_en.pdf" – "3.1 Adapter" for the specification and
restrictions for each CAD Adapter.

CATIA V5

• To install SmartLauncher (Plug-in) into a customized CATIA V5 environment, there are two
ways to do this:

◦ Inherit the customized environment settings to SmartLauncher (Plug-in)

Click [Create shortcut to start CAD] according to 5.2, “Initial Settings for SmartLauncher
(Plug-in)” and press . Specify the customized CATIA V5 environment file to "Copy
CATIA V5 ENV file from". Also, if you need to use the environment variables that were
set in the customized environment, set them in [More options] > [Environment
Variables] of 3DxSUITE setting.

◦ Add SmartLauncher (Plug-in) settings to the customized environment

Click [Create shortcut to start CAD] according to 5.2, “Initial Settings for SmartLauncher
(Plug-in)” and press . Specify the customized CATIA V5 environment file to "Copy
CATIA V5 ENV file from". When the process is completed, a new environment file is
created in the following path where both environments, customized and SmartLauncher
(Plug-in), coexist. (* is the version of CAD.)

%Public%\Documents\Elysium\3DxSUITE\Config\SmartLauncher\CATIAV5\R*\ELY_CATI
AV5_R*.txt

Copy the created environment file to the customized environment, and use this file to
start CATIA V5 in the customized environment.

3DEXPERIENCE

• To install SmartLauncher (Plug-in) into a customized 3DEXPERIENCE environment, there
are two ways to do this:

◦ Inherit the customized environment settings to SmartLauncher (Plug-in)

Click [Create shortcut to start CAD] according to 5.2, “Initial Settings for SmartLauncher
(Plug-in)” and press . Specify the customized 3DEXPERIENCE environment file to
"Copy 3DEXPERIENCE ENV file from". Also, if you need to use the environment variables
that were set in the customized environment, set them in [More options] > [Environment
Variables] of 3DxSUITE setting.
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◦ Add SmartLauncher (Plug-in) settings to the customized environment

Click [Create shortcut to start CAD] according to 5.2, “Initial Settings for SmartLauncher
(Plug-in)” and press . Specify the customized 3DEXPERIENCE environment file to
"Copy 3DEXPERIENCE ENV file from". When the process is completed, a new
environment file is created in the following path where both environments, customized
and SmartLauncher (Plug-in), coexist. (**** is the version of CAD.)

%Public%\Documents\Elysium\3DxSUITE\Config\SmartLauncher\3DEX\R****x\ELY_3DE
X_ASL_R****x.txt

Copy the created environment file to the customized environment, and use this file to
start 3DEXPERIENCE in the customized environment.

• To use SmartLauncher (Standalone), use 5.2, “Initial Settings for SmartLauncher (Plug-in)”
as a reference to open [3DxSUITE Setting] > [CAD] tab > [3DEXPERIENCE] tab. Press ( ) to
set the configuration keyword "3DEX_LoginTicket". Please refer to "3DEXPERIENCE
Importer / Exporter" in "Elysium 3DxSUITE Component Manual" for how to obtain
3DEX_LoginTicket.

NX

• Below are the ways to use SmartLauncher (Plug-in) either in a customized NX environment
(including NX in Teamcenter environment) or via a default CAD launch shortcut.

◦ Inherit the customized environment settings to SmartLauncher (Plug-in)

Click [Create shortcut to start CAD] according to 5.2, “Initial Settings for SmartLauncher
(Plug-in)” and press . Specify the path of the file specified by
"UGII_CUSTOM_DIRECTORY_FILE" (e.g., custom_dirs.dat) in the customized environment
to "Copy custom_dirs.dat from".

◦ Add SmartLauncher (Plug-in) settings to the customized environment

Use one of the following ways to add the SmartLauncher (Plug-in) settings to the
customized environment.

A. Specify the path of "SmartLauncher (Plug-in) for NX" installation folder in
"UGII_CUSTOM_DIRECTORY_FILE" (such as "custom_dirs.dat") which is used when
starting the customized NX.

B. Specify the path of "SmartLauncher (Plug-in) for NX" installation folder in
"UGII_USER_DIR" environment variable.

The path of SmartLauncher (Plug-in) for NX installation folder is as follows.

▪ SmartLauncher installation folder is:
<3DxSUITE Installation Folder>\SmartLauncher\cad_plugin\114\<NX version>
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 (Example) C:\Program Files\Elysium\3DxSUITE\SmartLauncher\cad_plugin\114\NX1953



Please note that when launching NX via Teamcenter and running Scenarios for
DFX, the PowerShell path will disappear in the batch that starts Teamcenter
Rich Client, preventing DFX components from running. To run successfully,
specify the PowerShell folder in the environment variable "AUX_PATH" as
shown below.

AUX_PATH=C:\WINDOWS\System32\WindowsPowerShell\v1.0\

Creo Parametric

• Below are the ways to use SmartLauncher (Plug-in) either in a customized Creo Parametric
environment or via a default Creo Parametric launch shortcut.

1. Create "protk.dat" file in any place. Enter the following contents in this file. (For users
who have installed SmartLauncher in the default folder, and using Creo Parametric 6.0
with it)

NAME ELY_CREOP_CONVERTER_PLUG_IN

EXEC_FILE C:\Program Files\Elysium\3DxSUITE\SmartLauncher\cad_plugin\104\Creo6\dll\PDMProe.dll

TEXT_DIR C:\Program Files\Elysium\3DxSUITE\SmartLauncher\cad_plugin\104\Creo6\text_fbt

REVISION Wildfire

STARTUP dll

END

2. Add the following line to "config.pro" that Creo Parametric loads at startup. (By default,
<Creo Parametric Installation folder>\Common Files\text\config.pro will be loaded)

PROTKDAT <Full path of protk.dat, created in step 1.>

• Please note that two seats of license on Creo Parametric will be required when launching
to/from Creo Parametric translation under the conditions below:

◦ Using a plug-in Adapter

◦ "On-memory translation" option disabled

◦ With Creo Parametric license file which does not include the keyword "DUP_GROUP"
because 3DxSUITE SmartLauncher newly launches Creo Parametric regardless of
whether Creo Parametric is already running.
(3DxSUITE SmartLauncher uses the currently opened Creo Parametric when on-memory
translation is enabled.)

SOLIDWORKS
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• SmartLauncher (Plug-in) for SOLIDWORKS will not appear on the menu just by installing it.
Follow the steps below to enable it.

1. Launch SOLIDWORKS by using "3DxSUITE SmartLauncher for SOLIDWORKS 20**". (20**
is a version of SOLIDWORKS)

2. Select [Tools] > [Add-Ins] from the menu.

3. In "Add-Ins" dialog, enable "Elysium Tool for SOLIDWORKS".

4. Click [OK] to close the "Add-Ins" dialog.

5.3. Launch
This section shows the instructions on how to run SmartLauncher.

5.3.1. Launch SmartLauncher (Standalone)

Start standalone type of 3DxSUITE SmartLauncher from the context menu of File Explorer as
follows.

1. Right-click a file to translate, and then select [Elysium] > [Convert/Change File Type] from
the context menu. For Windows 11, select [Show more options], and then select [Elysium].

2. "Open" dialog will appear where you can specify the folder and the filename to save the
result data, and the file format to translate.

5.3.2. Launch SmartLauncher (Plug-in)

To launch SmartLauncher (Plug-in), either start from the Windows menu or the shortcut on
desktop.

• To start from the Windows menu, run the batch of CAD / version you want to start from the
menu below.

◦ [Elysium 3DxSUITE SmartLauncher] > [3DxSUITE SmartLauncher for (CAD system
name) (Version)].

• To start from the shortcut, double-click "3DxSUITE SmartLauncher for (CAD system name)
(Version)" on your desktop.

Elysium 3DxSUITE Installation Guide

 © 2022 Elysium Page 85 | 193



Fig. 1. Example shortcut to start CATIAV5 R30



Only certain versions of CAD as listed below can launch SmartLauncher
(Plug-in) from the CAD UI. Please refer to "Supported CAD Version" list in
the Release Note for more details about CAD versions where the user can
launch SmartLauncher (Plug-in) from CAD UI.

◦ CATIA V5

◦ 3DEXPERIENCE

◦ Creo Parametric

◦ NX

◦ SOLIDWORKS

For those CAD versions where the user cannot launch SmartLauncher
(Plug-in) from CAD UI, translation can be performed only from the context
menu.

SmartLauncher (Plug-in) will be integrated into menu bar of CAD systems as below.

CAD Where SmartLauncher (Plug-in) is displayed

CATIA V5

3DEXPERIENCE

*When specifying "*_Elysium" as I/O file format, translation will be
executed.
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CAD Where SmartLauncher (Plug-in) is displayed

Creo

NX

SOLIDWORKS

 

5.4. Uninstallation

 You need Administrator privileges to uninstall Elysium products.



Please note that when uninstalling SmartLauncher (Plug-in) by the following
procedure, the process will end but the application will not be deleted.

1. Install 3DxSUITE SmartLauncher Base and SmartLauncher (Plug-in) using
Components installer.

2. Specify 3DxSUITE SmartLauncher Base directly and uninstall it.

3. Uninstall Components.

This behavior is caused by uninstalling 3DxSUITE SmartLauncher Base when
SmartLauncher (Plug-in) has already been installed. If this happens, specify
and uninstall SmartLauncher (Plug-in) directly instead of via Components.

5.4.1. Manual Uninstallation of SmartLauncher (Standalone)

1. From Windows start menu, select [Settings](Gear mark).
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2. Then select [Apps].

3. From the list of applications displayed in "Apps & features", select "Elysium 3DxSUITE EX9.1
- SmartLauncher Base" to uninstall.

5.4.2. Silent Uninstallation of SmartLauncher (Standalone)

Run command prompt as an administrator, and run the installer with arguments below. This
will allow you to uninstall SmartLauncher (Standalone) without any user interaction.

Sample Command:

Elysium_3DxSUITE_EX9.1_SmartLauncher_Base.exe /s /x /v"/l*
\"C:\temp\uninstall.log\"/qn"

5.4.3. Manual Uninstallation of SmartLauncher (Plug-in)

1. From Windows start menu, select [Settings](Gear mark).

2. Then select [Apps].

3. From the list of applications displayed in "Apps & features", select "Elysium 3DxSUITE EX9.1
- SmartLauncher (*** Plug-in)" to uninstall. (*** is the CAD name.)

5.4.4. Silent Uninstallation of SmartLauncher (Plug-in)

Run command prompt as an administrator, and run the installer with arguments below. This
will allow you to uninstall SmartLauncher (Plug-in) without any user interaction. When
specifying the executables, the files must correspond to SmartLauncher (Plug-in) that you want
to uninstall.

Sample Command (For SmartLauncher (Plug-in) for CATIA V5):

Elysium_3DxSUITE_EX9.1_SmartLauncher_CATIA_V5.exe /s /x /v"/l*
\"C:\temp\uninstall.log\"/qn"

This is a list of command arguments to pass to the installer when executing silent
uninstallation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/x Execute uninstallation. Mandatory
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Command
Argument

Description Mandatory /
Optional

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional
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6. Elysium 3DxSUITE SmartController
Programs that need to be installed in advance

• Components
(3DxSUITE Component Base, 3DxSUITE SmartLauncher Base)


Before launching SmartController, you are required to set the license setting in
3DxSUITE Setting.


Please note that when SmartController is launched for the first time, the
license setting configured in 3DxSUITE Setting will be used. After the first time,
the license setting configured in SmartController will take precedence to be
used.

6.1. Installation


You need Administrator privileges to install Elysium products.
If the required program is not installed beforehand, execution will abort.

6.1.1. Manual Installation

1. Run the installer for SmartController.

◦ Folder containing the installer: <3DxSUITE SmartController Package>\

◦ Installer: Elysium_3DxSUITE_EX9.1_SmartController.exe

2. Select the language for the installation and click [OK]. Japanese and English are available.

3. Install Wizard starts. Click [Next].
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4. Select "I accept the terms of the license agreement" if you agree, and then click [Next]. If you
disagree, you cannot continue the installation.

5. Destination folder for installation will be displayed. It will be installed in the folder specified
in 3DxSUITE Component Base and cannot be changed. Click [Next].
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6. Disable "Create a desktop shortcut" if you do not want to create a desktop shortcut. Click
[Install] to start the installation.

7. The following dialog will appear when installation is completed. Click [Finish] to close the
installer.
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6.1.2. Silent Installation

By using the command, you can install or upgrade SmartController without GUI operations.

• Example of command

Elysium_3DxSUITE_EX9.1_SmartController.exe /s /v"/l* \"C:\temp\install.log\"
INSTALLDIR=\"C:\Program Files\Elysium\3DxSUITE\EX9.1\SmartController\" /qn"

This is a list of command arguments to pass to the installer when executing silent installation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• INSTALLDIR=\"<Installation Folder>\" : Specify the folder
where you want to install. This can be specified only
when installing.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional
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6.2. Launch
In Windows start menu, select [Elysium 3DxSUITE] > [3DxSUITE SmartController] to launch. Or
double-click [3DxSUITE SmartController] shortcut on your desktop to launch.

6.3. Exit
Close the window to exit.

6.4. Uninstallation

6.4.1. Manual Uninstallation

1. From Windows start menu, select [Settings](Gear mark).

2. Then select [Apps].

3. From the list of applications displayed in "Apps & features", select "Elysium 3DxSUITE EX9.1
- SmartController" to uninstall.

6.4.2. Silent Uninstallation

Silent uninstallation can be performed by a command. Installer for the version you are
currently using will be required. Please refer to the following command example and the
explanation in Command Argument.

• Example of command

Elysium_3DxSUITE_EX9.1_SmartController.exe /s /x /v"/l*
\"C:\temp\uninstall.log\" /qn"
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7. Elysium 3DxSUITE SmartController Pro
Programs that need to be installed in advance

• n/a


Please ensure to set license-related settings in 3DxSUITE Setting before
launching SmartController Pro.


Please note that the first time you launch SmartController Pro, the license
setting configured in 3DxSUITE Setting will be used. After the first time, the
license setting configured in SmartController Pro will take precedence to be
used.

7.1. Installation

 You need Administrator privileges to install Elysium products.

7.1.1. Manual Installation

1. Run the installer for SmartController Pro.

◦ Folder containing the installer: <3DxSUITE SmartController Pro Package>\

◦ Installer: Elysium_3DxSUITE_EX9.1_SmartController_Pro.exe

2. Select the language for the installation and click [OK]. Japanese and English are available.

3. When this dialog appears, click [Install].
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4. If Setting Utility is not installed, the Setting Utility installer will start. Follow the steps below
to perform the installation. If Setting Utility is already installed, skip to the step after
installing Setting Utility.

a. Select which language to use when installing, and click [OK].

b. If above dialog is displayed, click [Install] to start the installation. If 3DxSUITE Setting
Utility is already installed, this dialog will not appear.

c. Installation Wizard starts. Click [Next].
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d. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.

e. "Set up Elysium License" dialog will appear. Enter Host name of the computer where you
installed Sentinel RMS License Manager, and if necessary, change Port number. And
then click [Next].
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f. "Set up Folders" dialog will appear. Change the folder path if necessary, and then click
[Next].

g. Click [Install] to start the installation.
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h. When the installation of Setting Utility is completed, the following dialog will appear.
Click [Finish] to close the installer.

i. When a dialog appears prompting you to reboot, then reboot the OS. After the OS has
rebooted, continue with the next step.

5. If Elysium 3DxSUITE Ruby is not installed in the environment, Elysium 3DxSUITE Ruby
installer will start. Follow the steps below to perform the installation. If Elysium 3DxSUITE
Ruby is already installed, skip to the step after installing Elysium 3DxSUITE Ruby.

a. Select which language to use when installing, and click [OK].

b. Installation Wizard starts. Click [Next].
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c. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.

d. "Destination Folder" dialog will appear. To change the destination folder from default
setting, click [Change] and specify the new destination folder. When the setting is
finished, click [Next].
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
Please ensure that the destination folder path consists only of one-byte
alphanumeric characters and several one-byte symbols ("#", "+", "-", "_",
".", "$", "/", ":"). If characters other than these are included in the path,
an error will occur.

e. Click [Install] to start the installation.

f. When installation is completed, the following dialog will appear. Click [Finish] to end the
installer.
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6. Install Wizard starts. Click [Next].

7. Select "I accept the terms of the license agreement" if you agree, and then click [Next]. If you
disagree, you cannot continue the installation.
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8. "Destination Folder" dialog will appear. To change the destination folder from default
setting, click [Change] and specify the new destination folder. When the setting is finished,
click [Next].


Please ensure that the destination folder path consists of ASCII characters
only. If the folder path contains non-ASCII characters, the application may
not work as expected.

9. Disable "Create a desktop shortcut" if you do not want to create a desktop shortcut. Click
[Install] to start the installation.

10. The following dialog will appear when installation is completed. Click [Finish] to close the
installer.
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7.1.2. Silent Installation

By using the command, you can install or upgrade SmartController Pro without GUI operations.

• Example of command

Elysium_3DxSUITE_EX9.1_SmartController_Pro.exe /s /v"/l* \"C:\temp\install.log\"
INSTALLDIR=\"C:\Program Files\Elysium\3DxSUITE\EX9.1\SmartController_Pro\" /qn"

This is a list of command arguments to pass to the installer when executing silent installation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• INSTALLDIR=\"<Installation Folder>\" : Specify the folder
where you want to install. This can be specified only
when installing.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional
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7.2. Launch


Please note that when SmartController Pro is launched for the first time, the
license setting configured in 3DxSUITE Setting will be used. After the first time,
the license setting configured in SmartController Pro will take precedence to
be used.

In Windows start menu, select [Elysium 3DxSUITE] > [3DxSUITE SmartController Pro] to launch.
Also, launch SmartController Pro by clicking [3DxSUITE SmartController Pro] shortcut on the
desktop.

7.3. Exit
Close the window to exit.

7.4. Uninstallation

7.4.1. Manual Uninstallation

1. From Windows start menu, select [Settings](Gear mark).

2. Then select [Apps].

3. From the list of applications displayed in "Apps & features", select "Elysium 3DxSUITE EX9.1
- SmartController Pro" to uninstall.

7.4.2. Silent Uninstallation

Silent uninstallation can be performed by a command. The installer for the version you are
currently using will be required.
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• Example of command

Elysium_3DxSUITE_EX9.1_SmartController_Pro.exe /s /x /v"/l*
\"C:\temp\uninstall.log\" /qn"

This is a list of command arguments to pass to the installer when executing silent
uninstallation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/x Execute uninstallation. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional
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8. Elysium 3DxSUITE TransServer
Programs that need to be installed in advance

• None

8.1. Installation



• TransServer and WorkerNode should refer to the same License Server.

• Please ensure that the host name resolution works bi-directionally between
TransServer (A) and WorkerNode (B).

• By default, TransServer allocates jobs based on the assumption that all
licenses on the referenced License Server are available. If other Elysium
products or other TransServer are set to refer to the same License Server,
an error may occur when allocating jobs.

 You need Administrator privileges to install Elysium products.

TransServer does not support silent installation. Perform manual installation.

8.1.1. Setup of Shared Folder

The computer where TransServer is installed and the computer where WorkerNode is installed
must share one folder with the same file path (Ex. N:\share). This section will explain how to set
up a folder (hereinafter referred to as "shared folder") that will be shared across the network
on each computer.

Please note the following when you set a shared folder.

• A shared folder needs to be assigned in a large-capacity drive because the output folder
and the work folder of data processing are created under the shared folder.

• UNC path (path which starts with "\\") cannot be used as the shared folder.

• Root folders of drives (like "N:\") cannot be used as the shared folder.
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The folder "\\server1\3dxsuite\share" in the computer named "server1" is used as the shared
folder in the above example. In this regard, change the path "\\server1\3dxsuite\share" to
"N:\share" with assigning the folder "\\server1\3dxsuite" to N drive ("N:\") and use the path
"N:\share" as the shared folder, because UNC paths cannot be used as the shared folder.

How to assign a drive letter to UNC path

1. Right-click on "This PC" and select "Map network drive."

2. Select a drive letter from the pull-down menu, then enter UNC path in the Folder field
and click [Finish].
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Perform the above-mentioned setting to all the computers where WorkerNodes are
installed and the computers which use WorkerNode.

8.1.2. Installation of PostgreSQL

Install PostgreSQL. This version of 3DxSUITE TransServer supports version 12.* of PostgreSQL.
Download the installer of PostgreSQL 12.* from the following page:

1. Download the installer of PostgreSQL 12.* (Windows x86-64) from the following page:

◦ https://www.enterprisedb.com/downloads/postgres-postgresql-downloads

2. Install PostgreSQL according to the installer instructions.

◦ Run the installer after logging in as Administrator.

◦ Create an installation folder for PostgreSQL in advance where "everyone" has been
granted full permission to refer to before running the installer.
(e.g., C:\Program Files\PostgreSQL\12)

◦ Select Components
Please make sure to install both "PostgreSQL Server" and "pgAdmin4".

◦ Data Directory
The following path is specified by default setting.
C:\Program Files\PostgreSQL\12\data
If data files are stored in a folder under Program Files as default setting, some problems
may occur depending on versions of OS. Therefore, create a folder directly under the
drive such as the following path and then change the path of Data Directory from default
setting to this folder you have created.
(e.g., C:\pgdata\12)

◦ Password
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Enter the password for PostgreSQL administrator. The string of the password which is
set here is described in plain text in the following configuration file.
<3DxSUITE TransServer Installation Folder>\k2dashboard\config\database.yml

◦ Advanced Options
Click "C" in the Locale pull-down menu.

3. After the installation, restart the computer, run Windows Services list, and confirm that the
service "postgresql-x64-12 - PostgreSQL Server 12" or "postgresql-x64-12" exist in the list,
and then move onto the next step.

◦ For the service list, press Windows key + [R] key at the same time. Enter "services.msc"
in [Run] window and click [OK].

◦ If the service does not exist, it means that the installation of PostgreSQL has failed. Retry
installing PostgreSQL until it is completed. Refer to "15. Troubleshooting" at the end of
this document or search for information on the internet.

8.1.3. Installation of 3DxSUITE TransServer

Install TransServer with the following steps.

1. Run the installer for TransServer.

◦ Folder containing the installer: <3DxSUITE TransServer Package>\

◦ Installer: Elysium_3DxSUITE_EX9.1_TransServer.exe

2. Select the language for the installation and click [OK]. Japanese and English are available.

3. If this dialog appears, click [Install] and install Ruby. 
(This dialog will not appear under the environment in which Ruby has already been
installed.)
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4. The installer of Elysium 3DxSUITE Ruby starts. If Elysium 3DxSUITE Ruby has already been
installed, go to step 11.

5. Select the language for the installation and click [OK].

6. Installation Wizard starts. Click [Next].
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7. Read through the license agreement carefully. Select "I accept the terms in the license
agreement" if you agree, and then click [Next]. If you disagree, you cannot continue the
installation.

8. "Destination Folder" dialog will appear. To change the destination folder from the default
setting, click [Change] and specify the new destination folder. When the setting is finished,
click [Next].


Please ensure that the destination folder path consists only of one-byte
alphanumeric characters and several one-byte symbols ("#", "+", "-", "_", ".",
"$", "/", ":"). If characters other than these are included in the path, an error
will occur.
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9. Click [Install] to start the installation.

10. When the installation has been completed, the following dialog will appear. Click [Finish].
The installer of Elysium 3DxSUITE Ruby finishes, and you will go back to the installer of
TransServer.

11. After the installation of Ruby, Installation Wizard for 3DxSUITE TransServer starts. Click
[Next].
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12. Read through the license agreement carefully. Select "I accept the terms in the license
agreement" if you agree, and then click [Next]. If you disagree, you cannot continue the
installation.

13. The dialog to specify the installation folder appears. You can change the installation folder
from the default setting by clicking [Change] at the upper right and specifying a new folder.
Confirm that "New Installation" is selected, and then click [Next].

Elysium 3DxSUITE Installation Guide

 © 2022 Elysium Page 114 | 193




Please note that the length of your installation folder path should be 80
characters or less. If the path is longer than 80 characters, TransServer may
not work properly.

14. Specify a folder to save the resources, and click [Next].


Please ensure to specify either the local drive path or UNC path as the
resource folder. Avoid specifying a path which includes a network drive
(e.g., N:\transserver\resources) because TransServer may not run properly.

15. Specify a destination folder for Ruby and click [Next].
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16. Specify "Host name" and "Port number" of Elysium License Server, and "Listen port" of
TransServer. You should specify the same License Server as WorkerNode. Click [Next] once
completed.

17. Enter the name of the database and the password you set in the installation of PostgreSQL.
When installing PostgreSQL, if PostgreSQL port number has not changed from 5432, then no
change is required. In the default setting, the string "trans_server_ex*_*_*" is entered as the
database name (*_*_* is the version of PostgreSQL). You do not need to change this name as
long as this is the first time installation. If not, and the previous database has not been
deleted, enter a unique name that has not been used before.
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18. Specify the "Shared Folder" that you have set at Setup of Shared Folder.
(e.g., N:\share）

19. Select whether to register or not as Windows Service. If you select [Register as a Windows
service], go to step 20. If you select [Don’t Register as a Windows service], go to step 22.
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

When you register TransServer as Windows Service, it will automatically
start when the computer is booted. Therefore, the user does not have to
interactively log on to the computer and start it.
When you do not register TransServer as Windows Service, the processing
information will be output to command prompt, so if an error occurs, you
will have more information.
Usage example: Use the service for normal operation of TransServer, and
when a problem occurs which needs to be investigated or tested
temporarily, interactively start it.
Depending on the purpose of use and assumptions, select the appropriate
method.

20. Set the same configurations as you have set at Setup of Shared Folder and click [Next].
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

Drive letter and network folder path specified above can be found with the
"net use" command.
When running the command, you will see a list of network drives. Based on
the settings in 9.1.1, “Prerequisite: Setup of Shared Folder”, specify them in
"Common configuration" dialog.

21. Enter the username and password of the user who has read and write permission on the
specified shared folder, then click [Next]. When specifying a user registered in Active
Directory, leave the input field at the bottom of the screen blank.

When installing in an environment without Active Directory or when using a user not
registered in Active Directory, enable the option "Register a User in an environment without
Active Directory", and enter the username and password of a user authorized to access the
UNC path in the input field at the bottom of the screen.
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22. Click [Install], and the installation starts.

23. When the installation has been completed, the following dialog appears. Click [Finish].
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24. If you register TransServer as Windows Service, open Windows Service to confirm
"3DxSUITE EX9.1 TransServer Service". If you have confirmed that the service exists and is
running, you have succeeded the installation.



◦ For the service list, press Windows key + [R] key at the same time. Enter
"services.msc" in [Run] window and click [OK].

◦ TransServer may not be available even though the service is running.
In that case, start Task Manager and confirm whether httpd.exe process
is running.

25. Give "Full Control" permission on the installation folder of TransServer to the user who
executes TransServer.

26. Follow the steps below to configure the WorkerNode.

a. Start TransServer. Please refer to 8.4, “Launch” on how to start it.

b. Log in as the administrator and open [Administration] > [Services Monitor].

c. Click [Edit].

d. Click [Add].

e. Enter Host name and Port number of WorkerNode you will be adding and click [Save].


By specifying the "Reverse Port", you can specify the port of
TransServer that receives the communication from WorkerNode. This
field is optional. If not specified, the ephemeral port will be used.

27. Allow the communicate to TransServer through Windows Firewall.

a. Press both [Windows] key and [R] key at the same time to start [Run].

b. In "Open" field, enter "control.exe /name Microsoft.WindowsFirewall", and click [OK].
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c. In the left pane, click "Allow an app or feature through Windows Defender Firewall."

d. Click [Allow another app], and allow access for the following programs:

▪ Ruby: 
<Ruby installation folder>\rubies\ruby-2.7.6\bin\ruby.exe
(Default path: C:\ProgramData\Elysium\3DxSUITE\Ruby\2.7.6\rubies\ruby-
2.7.6\bin\ruby.exe)

▪ Apache HTTP Server:
<TransServer Installation Folder>\Apache\<Version>\Apache24\bin\httpd.exe

e. Click [OK].


This step is not necessary if you have specified the reverse port in step
26. Instead, configure your firewall to allow access to the specified
reverse port.

8.1.4. Installation of Multiple WorkerNodes

Please refer to 9.2.7, “Copy Configuration of Existing WorkerNode” at the end of this document.

Adjust the maximum number of concurrent connections to PostgreSQL when you specify more
than five WorkerNodes. Regarding the instruction on setting, please refer to "Configuring Max
Concurrent Connections to Database" of "Manual for Administrator."

8.2. Upgrade Installation

8.2.1. Notes for Upgrading

• 3DxSUITE TransServer EX9.1 supports the upgrade from 3DxSUITE TransServer EX9.0.*. If
you are currently using versions before EX9.0 (ASFALIS TransServer), upgrade to 3DxSUITE
TransServer EX9.0 first, and then upgrade to 3DxSUITE TransServer EX9.1.

• When you perform an upgrade installation, all data and settings will be kept as they are.

• Upgrading does not affect the previous environment. However, just in case, make a backup
of 3DxSUITE TransServer before upgrading. To make a backup, please refer to "6 Backup &
Restore" of "Manual for Administrator."

• A password needs to be specified in the file "%APPDATA%\postgresql\pgpass.conf" in
advance.

1. Start pgAdmin 4. Select Windows [Start] > [PostgreSQL 12.*] > [pgAdmin 4].

2. Double-click PostgreSQL 12.* (localhost: 5432, if installed by default settings) from the
object browser. Enter the password and enable "Save Password" in "Connect to Server"
dialog, and then click [OK].
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If the password has already been saved, the "Connect to Server" dialog will not appear.

3. Close pgAdmin 4. You must close pgAdmin 4 before installing TransServer.

• Please ensure to stop ASFALIS TransServer or 3DxSUITE TransServer before performing an
upgrade installation.

• When an earlier version of ASFALIS TransServer or 3DxSUITE TransServer is registered as
service, stop ASFALIS TransServer / 3DxSUITE TransServer service and change its "Startup
type" to "Manual" beforehand. This is to avoid multiple versions of ASFALIS TransServer or
3DxSUITE TransServer services from running in parallel. Follow the steps below:

1. Press Windows key + [R] at the same time. Enter "services.msc" in [Run] window and
click [OK].

2. Stop "3DxSUITE EX9.1 TransServer Service".

3. Open the property of "3DxSUITE EX9.1 TransServer Service" and change "Startup type"
to "Manual".

4. Click [OK] to close the property window.

5. Perform upgrade installation.

8.2.2. Installation of TransServer

Install 3DxSUITE TransServer with the following steps.

1. Run the installer for TransServer.

◦ Folder containing the installer: <3DxSUITE TransServer Package>\

◦ Installer: Elysium_3DxSUITE_EX9.1_TransServer.exe

2. Follow the same steps as the fresh installation (not the upgrade) for the installation of
Elysium 3DxSUITE Ruby and the screen transition of TransServer.

3. Specify the installation folder of TransServer in "Destination Folder" dialog as follows.

Install Elysium 3DxSUITE TransServer to

Specify the installation folder of TransServer. You can change the installation folder from
the [Change] at upper right. Please ensure to specify a different folder from "Installation
folder of Elysium 3DxSUITE TransServer previous version."
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Installation folder of Elysium 3DxSUITE TransServer previous version

Specify the installation folder of previous version of TransServer. You can change the
installation folder from the [Change] at bottom right.

Select the installation option from "Upgrade (copy resource)" or "Upgrade (share resource)."

◦ Upgrade (copy resource): Copy the resource of the previous version and use as the
resource of newly installed version.

◦ Upgrade (share resource): Share the resource of the previous version. Select this option
in case the resource folder has been changed from the default setting due to the
limitation of the free disk space.

4. Enter the name of the database and the password for PostgreSQL set at the installation in
"PostgreSQL Configuration" dialog. The default value for Database name is
trans_server_ex*_*. (*_* is the version number) When upgrading installation, please make
sure to give a unique name which has never been used as the database name.
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5. Follow the steps of the Wizard. When the installation has been completed, the following
dialog will appear. Click [Finish] to close the dialog.



◦ Please ensure to enter the username and password of the user who has
the write and read access to the shared folder when registering
3DxSUITE TransServer as Windows Service.

◦ When you do not have Active Directory environment, and you want to
register TransServer as Windows Service, select "Don’t register as a
Window service" from the Wizard. Moreover, perform the service
registration manually by following the instruction on 9.2.4, “Register
and Delete Windows Service”.
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

When you register TransServer as Windows Service, it will automatically
start when the computer is booted. Therefore, the user does not have to
interactively log on to the computer and start it.
When you do not register TransServer as Windows Service, the processing
information will be output to command prompt, so if an error occurs, you
will have more information.
Usage example: Use the service for normal operation of TransServer, and
when a problem occurs which needs to be investigated or tested
temporarily, interactively start it.
Depending on the purpose of use and assumptions, select the appropriate
method.

6. If you register TransServer as Windows Service, open Windows Service to confirm
"3DxSUITE EX9.1 TransServer Service". If you have confirmed that the service exists and is
running, you have succeeded the installation.



◦ For the list of services, press Windows key + [R] key at the same time.
Enter "services.msc" in [Run] window and click [OK].

◦ TransServer may not be available even though the service is running.
In that case, start Task Manager and confirm whether httpd.exe process
is running.

7. Give "Full Control" permission on the installation folder of TransServer to the user who
executes TransServer.

8.2.3. Deletion of the Database

Follow the steps below on how to delete the old TransServer database after you have finished
upgrading. Please note that this action is not mandatory.

1. Select Windows [Start] > [PostgreSQL 12] > [pgAdmin 4].

2. Double-click [PostgreSQL 12] (if default setting, select localhost: 5432) from the object
browser, and enter the password for PostgreSQL set during installation in the "PostgreSQL
Configuration" dialog. Open the database, right-click the database name which is by default
trans_server_ex*_* (*_* is the version number), and select [Delete].

8.3. Settings after the Installation

8.3.1. How to Change the Number of Application Server Instances

Change the number of Application Server instance depending on the number of concurrent
users. Please refer to "Tuning Application Server Management Settings" of "Manual for
Administrator."
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8.3.2. How to Change the Resource Folder

Change the resource folder depending on the free disk space.

1. Stop TransServer if it is running.

2. Execute the following file and start command prompt.
<3DxSUITE TransServer installation folder>\k2dashboard\start-console.bat

3. Execute the following command:

bundle exec rake ats:resources:copy RESOURCE_PATH=(the path to the resource
folder)

4. Delete the resource folder which existed before the change.

5. Open the following file with text editor.
<3DxSUITE TransServer installation folder>\config\k2server.ini

6. Change the value of "PrivateResourcePath" in K2server section to "the path to the resource
folder."(*)

7. Restart TransServer.

(*) The detail specified here will be necessary when upgrading the version; therefore, we
urge you to keep a record somehow.


Please ensure to specify either the local drive path or UNC path as the resource
folder. Avoid specifying a path which includes a network drive (e.g.,
N:\transserver\resources) because TransServer may not run properly.

8.3.3. How to Change the License Configuration

If the license server is changed, you need to change the configurations for TransServer and all
WorkerNodes.

TransServer

1. Open the following file with text editor.
<3DxSUITE TransServer installation folder>\set_ruby_env.bat

2. Old values are written for "ELY_SEC_SERVER" and "ELY_SEC_PORT", so change them to
the new hostname and the port number and overwrite the files.

3. Restart TransServer.

WorkerNodes

1. Open WorkerNode Setting dialog.
Menu: Start > [Elysium 3DxSUITE WorkerNode] > [Setup 3DxSUITE WorkerNode EX9.1]

2. Select a node from the node list and open [Common] tab. Enter Hostname and Port
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number of the new license server. Then click [Apply].

3. Restart WorkerNodes.

TransServer and WorkerNode should refer to the same License Server.

8.3.4. How to Change the Shared Folder

If you want to change the path of the shared folder specified at the time of installation, follow
the procedure below to change the setting. Please refer to Setup of Shared Folder for notes on
setting the shared folder.

1. Stop TransServer if it is running.

2. Open the following file with a text editor.
<3DxSUITE TransServer installation folder>\set_ruby_env.bat

3. Edit the shared network folder path defined with the following:
"@set SHARED_FOLDER="

4. Save and close the text editor.

5. Start TransServer.

Go through the following steps as well if you have registered TransServer as Windows Service,
and changed the network drive settings.

1. Stop TransServer service if it is running.

2. Open the following file with a text editor.
<3DxSUITE TransServer installation folder>\config\k2server.ini

3. Edit the network drive settings defined with the following:
SharedFolderDriveLetter=
SharedFolderUncPath=

4. Save and close the text editor.

5. Start TransServer service.

8.4. Launch
If you have registered TransServer as Windows Service:

TransServer Service will boot automatically when you turn on the computer.

If 3DxSUITE TransServer is started properly, "event with ID 0" will be recorded in the
application event log. If a problem occurs while starting, "event with ID 818" or "event with
ID 819" will be recorded.

If you have not registered 3DxSUITE TransServer as Windows Service:

Start 3DxSUITE TransServer.
Execute the menu [Elysium 3DxSUITE TransServer] > [Start 3DxSUITE TransServer EX9.1] in
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the Start menu.
Then, following windows will open.

• TransServer

• Kloggr

• Apache

• k2scheduler

• Rails <number>


Please note that you cannot start TransServer from start menu when the
TransServer service is already running.

8.4.1. Server Configurations

Open the following address in a web browser on a client computer and log in as Administrator.

Address http:// <Machine name of TransServer>:<Port number(Default:3000)>

(e.g.) http://server:3000

Default account User Name: admin
Password: admin

Select [Admin Menu] > [Server Configurations] and configure the following items suitable for
your environment:

Configuration Name Description

1 system.default.timezone Default Time Zone

2 web.common.server_base_address Specify base URL of TransServer for users.

3 scheduler.error_mail.sender Specify sender of notification message in case of
job execution error.

4 scheduler.error_mail_recipient Specify recipient of notification message in case
of job execution error.

5 system.monitor.error_mail_recipient Specify recipient of notification message in case
of monitor error.

6 system.mail.smtp_server Specify SMTP server FQDN to send messages.

7 system.mail.smtp_port Specify SMTP port to send messages

8 system.mail.smtp_default_domain Specify the default domain to send messages.
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8.5. Exit
If you have registered TransServer as Windows Service

Stop TransServer service from Service List.

If 3DxSUITE TransServer is stopped properly, "event with ID 0" will be recorded in the
application event log. If a problem occurs while stopping, "event with ID 818" or "event with
ID 819" will be recorded.

If you have not registered 3DxSUITE TransServer as Windows Service

Execute the menu [Elysium 3DxSUITE TransServer] > [Stop 3DxSUITE TransServer EX9.1] in
the Start menu.

8.6. Uninstallation
When you reinstall TransServer, you first need to back up the current setting of TransServer
that is saved in the database, and then restore the setting to the new TransServer. Please refer
to "Manual for Administrator" for details on backing up and restoring.

TransServer does not support silent uninstallation. Perform manual uninstallation.

1. Uninstall the following programs from "Programs and Features" in the Control Panel. Please
ensure to stop TransServer beforehand. If it is registered as Windows Service, then stop
from there.

i. Elysium 3DxSUITE TransServer

ii. Elysium 3DxSUITE Ruby
Do not uninstall Ruby if other 3DxSUITE products are still installed on the same
computer and you are going to continue using them.

iii. PostgreSQL
Delete the database of TransServer instead of uninstalling PostgreSQL, if PostgreSQL is
also used for applications other than TransServer. Please refer to 8.2.3, “Deletion of the
Database” for details on how to delete the database.

2. Delete the installation folder of the uninstalled program.
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9. Elysium 3DxSUITE WorkerNode
Programs that need to be installed in advance

• Components

9.1. Installation

9.1.1. Prerequisite: Setup of Shared Folder

The computers where WorkerNode are installed and the client computers that use WorkerNode
need to share one folder with the same file path (Ex. N:\share). This section will explain how to
set up a folder (hereinafter referred to as "shared folder") that will be shared across the
network on each computer.

Please note the following when you set a shared folder.

• A shared folder needs to be assigned in a large-capacity drive because the output folder
and the work folder of data processing are created under the shared folder.

• UNC path (path which starts with "\\") cannot be used as the shared folder.

The folder "\\server1\3dxsuite\share" in the computer named "server1" is used as the shared
folder in the above example. In this regard, change the path "\\server1\3dxsuite\share" to
"N:\share" with assigning the folder "\\server1\3dxsuite" to N drive ("N:\") and use the path
"N:\share" as the shared folder because UNC paths cannot be used as the shared folder.
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How to assign a drive letter to UNC path

1. Right-click on "This PC" and select "Map network drive."

2. Select a drive letter from the pull-down menu, then enter UNC path in the Folder field
and click [Finish].

Perform the above-mentioned setting to all the computers where WorkerNodes are
installed and the computers that use WorkerNode.

9.1.2. Manual Installation


You need Administrator privileges to install Elysium products.
If the required program is not installed beforehand, execution will abort.

1. Run the installer for WorkerNode.

◦ Folder containing the installer: <3DxSUITE WorkerNode Package>\

◦ Installer: Elysium_3DxSUITE_EX9.1_WorkerNode.exe
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2. Select the language for the installation and click [OK]. Japanese and English are available.

3. Installation Wizard starts. Click [Next].

4. Read through the license agreement carefully. Select "I accept the terms in the license
agreement" if you agree, and then click [Next]. If you don’t accept, you cannot continue the
installation.
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5. "Destination Folder" dialog will appear. To change the destination folder from default
setting, click [Change] and specify the new destination folder. When the setting is finished,
click [Next].


Please ensure that the destination folder path consists of ASCII characters
only. If the folder path contains non-ASCII characters, the application may
not work as expected.

6. Click [Install] to start the installation.
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7. When the installation is completed, the following dialog will appear. Click [Finish] to finish
the installer.


Please ensure that the host name resolution works bi-directionally between the
computer on which SmartController Pro/TransServer are running and
WorkerNode.

9.1.3. Silent Installation

By using the command, you can install or upgrade WorkerNode without GUI operations.

• Example of command
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Elysium_3DxSUITE_EX9.1_WorkerNode.exe /s /v"/l* \"C:\temp\install.log\"
INSTALLDIR=\"C:\Program Files\Elysium\3DxSUITE\EX9.1\WorkerNode\" /qn"

This is a list of command arguments to pass to the installer when executing silent installation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• INSTALLDIR=\"<Installation Folder>\" : Specify the folder
where you want to install. This can be specified only
when installing.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional

9.2. Set up WorkerNode
From Windows start menu, select [Elysium 3DxSUITE WorkerNode] > [Setup 3DxSUITE
WorkerNode EX9.1] and the following dialog will start. WorkerNode setting is done on this
dialog.
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
Please refer to 9.2.7, “Copy Configuration of Existing WorkerNode” for how to
set up WorkerNode by copying the configuration of existing WorkerNode.

9.2.1. "Common Configuration" Dialog

Select [File] > [Common configuration] to display the "Common configuration" dialog.
In this dialog, you can set the following:

• Elysium License Server
Specify Host name and Port number of the computer on which the license server is running.

• Working Folder Settings
Set the folder information to be shared between the computer which has WorkerNode
installed and the computer which has SmartController Pro or TransServer installed. Specify
the drive letter and network folder path based on the settings made in 9.1.1, “Prerequisite:
Setup of Shared Folder”. If the user who starts the WorkerNode process or the user who
executes the WorkerNode service can access the specified network folder path, the user
name and password do not need to be specified.

• Miscellaneous
Specify the application to use when opening the log output by WorkerNode.
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

Drive letter and network folder path specified in "Working Folder Settings" can
be found with the "net use" command.
When running the command, you will see a list of network drives. Based on
the settings in 9.1.1, “Prerequisite: Setup of Shared Folder”, specify them in
"Common configuration" dialog.

9.2.2. [Common] tab

On [Common] tab, you can set the following:
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[WorkerNode]

• Listen port
Specify the port number to receive communication from the application using the
WorkerNode. Please ensure to specify a port which is not used by other programs.

• Label
Specify a label to classify WorkerNodes into groups. WorkerNodes which have the same
label will be regarded as being in the same group.
This is useful when you wish to assign a WorkerNode to use for a certain process. Specify
a WorkerNode group by the label with a parameter "WorkerNodeLabel" for each
Component, then the Component will be processed on one of WorkerNodes in the
specified group.
You can skip this field when you do not need to classify WorkerNodes into groups.
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9.2.3. [Component] tab

Set the information necessary to execute components, including activation of components to
use, destination folders of CADs, and so on.

[Common settings]

• Module folder
Specify the folder where the Components used by WorkerNode are installed.

[Settings of enabled components]

• Selectable components
List of Components (CAD Adapter and optimized Components) which are selectable in
this WorkerNode.

• Enabled components
Lists all Components which are available to run on that WorkerNode.

Add / Delete Components

1. Select the component you want to use in the list of "Selectable components," and click [Add].

 You must add "Geometry Healer" component.
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2. When adding a Component which has required setting, the following dialog will appear.
Click [Yes] to start the setting. Even if you click [No], you can configure the setting later by
clicking [Setting] for the Component you want to use.

3. When you click [Yes] in step 2 or click [Setting] later, "Component detailed setting" dialog
will appear. Set the required parameters including destination folders of CAD or boot
programs (the background of the value column is colored red), and the optional parameters
including template files or the timeout in getting licenses.


The settings in "Component detailed setting" dialog synchronizes with
3DxSUITE Setting Utility. When making any changes, select the appropriate
settings taking into consideration the usage situation, etc.

4. Click [OK], and the setting is finished.
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

When using Inventor Adapter, you must select [Tool] tab > [Add-Ins] to launch
the Add-In Manager, and disable "Block" in the Load Behavior for "Elysium
3DxSUITE Inventor Addin" in Inventor.

9.2.4. Register and Delete Windows Service

WorkerNode can be registered and started as a Windows service. When registered,
WorkerNode will automatically start when the computer starts, so the user is not required to
interactively log in and start.
To register or delete the Windows service, follow the below steps.

Register Windows Service

1. Select [Windows Service] > [Register] from the menu.

2. A dialog will appear. Enter the user name and password of the service execution user.

3. When "User Account Control" warning dialog appears, click [Yes] to execute.

4. Confirm the displayed dialog which indicates a successful registration of service.
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5. Select [File] > [Common Configuration] from the menu.

6. Set Host name and Port number of the license server used by each Component in "Elysium
License Server."

7. Enter the drive letter and network folder path (the same content that you specified in 9.1.1,
“Prerequisite: Setup of Shared Folder”) in "Working Folder Settings". Also, if the user who is
running the service configured in step 2 does not have permission to access this path, enter
the user name and password of the user who has access right.

8. Click [OK] to save the settings.



Drive letter and network folder path specified in "Working Folder Settings" can
be found with the "net use" command.
When running the command, you will see a list of network drives. Based on
the settings in 9.1.1, “Prerequisite: Setup of Shared Folder”, specify them in
"Common configuration" dialog.
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Some of the Components are not capable of running on WorkerNode that is running as a
service. Non-supported components should be executed on WorkerNode that are not registered
as Windows Service. At this point, the following is the 3DxSUITE component availability on
WorkerNode registered as Windows service.

Component Name Availability

CATIA V5(Plug-in) Yes

CATIA V5(standalone) Yes

3DEXPERIENCE 3DEXPERIENCE to ENF: Yes
ENF to 3DEXPERIENCE: No

CATIA V4 Yes

NX(Plug-in) Yes

NX(standalone) Yes

Creo Parametric(Plug-in) Yes

Creo Parametric(standalone) Yes

NX I-deas No

SOLIDWORKS No

Creo Elements/Direct Modeling Yes

Autodesk Inventor Yes

CADmeister(standalone) Yes

iCAD Yes

Solid Edge Yes

Parasolid Yes

ACIS Yes

STEP Yes

JT Yes

QIF Yes

3DXML Yes

IGES Yes

STEP AP242 BOM Yes
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Component Name Availability

PLM XML Yes

XPDMXML Yes

3D PDF Yes

XVL Yes

Creo View Yes

STL Yes

OBJ Yes

VRML Yes

Nastran Yes

Point Cloud Yes

Healing Yes

PDQ Checker Yes

Geometry Simplifier Yes

CAD Validator Yes

ENF Polygon Yes

Polygon Optimizer Yes

ENF Editor Yes


Whether the custom component can operate as a service depends on the
service support of the executable or batch file called from the custom
component.

Delete Windows Service

1. Select [Windows Service] > [Delete] from the menu.

2. When "User Account Control" warning dialog appears, click [Yes] to execute.

3. Confirm the displayed dialog which indicates a successful deletion of service.
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

When you register WorkerNode as Windows service, it will automatically start
when the computer is booted. Therefore, the user does not have to
interactively log on to the computer and start it.
When you don’t register WorkerNode as Windows service, the processing
information will be output to command prompt, so if an error occurs, you will
have more information.
Usage example: Use the service for normal operation of WorkerNode, and
when a problem occurs which needs to be investigated or tested temporarily,
interactively start it.
Depending on the purpose of use and assumptions, select the appropriate
method.

9.2.5. Set Up more than One WorkerNode

More than one node with different settings can be set in WorkerNode Setting.

Duplicate existing node

One node can perform only one processing at once. If you have more than one license
(Elysium license and CAD license) for the same component, utilize your licenses by setting
more than one node with the same settings.

Add new node

Add new nodes in case you want to create nodes which have completely different
components from existing nodes, such as creating a dedicated node for a specific CAD.

9.2.6. Advanced Settings

Enable the checkbox of [View] > [Show Advanced Setting] to show [Advanced settings] tab.
Specify the environment variables which will be used only for 3DxSUITE WorkerNode, and so
on.
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[Custom component]

• Custom component folder
This is the folder to add modules of external (non-3DxSUITE) components.

[Common settings]

• Environment variables
This is to specify the environment variables which will be used for WorkerNode. The
value specified in this section will be effective only for WorkerNode.

9.2.7. Copy Configuration of Existing WorkerNode

WorkerNode can also be set up by copying the configuration of an existing WorkerNode as
follows.

1. From Windows start menu, select [Elysium 3DxSUITE WorkerNode] > [Setup 3DxSUITE
WorkerNode EX9.1].

2. Select [File] > [Import] in the "WorkerNode Setting" dialog.

3. Select the configuration file of an existing WorkerNode (stored at the path below), and click
[Open] in the dialog.

◦ %Public%\Documents\Elysium\3DxSUITE\Config\WorkerNode\ServiceConfig.xml

4. Confirm in the "WorkerNode Setting" dialog that all the fields are filled for your needs, and
then click [OK] to start importing the settings.

5. Once the import is completed, click [Apply] in the dialog.

9.3. Start and Stop
The method of starting and stopping WorkerNode differs depending on whether you run it as
Normal Process or Windows Service.

Elysium 3DxSUITE Installation Guide

 © 2022 Elysium Page 147 | 193




Please ensure that WorkerNode running as a Windows service and
WorkerNode running as a normal process do not coexist on the same
computer.


When adding or changing a node while WorkerNode is running as a Windows
service, stop the service, change settings from [Node Settings], and start the
service again.



If WorkerNode is running as a normal process, do not start the Windows
service of WorkerNode. By default, WorkerNode service automatically starts
when the computer is started. Disable automatic start of the Windows service
of WorkerNode if necessary.
When adding a node or changing settings when executing as a normal process,
stop the node, change the settings from [WorkerNode Settings], and start the
node again.

Start as Normal Process

There are three ways to start / stop WorkerNode as a normal process.

[Start / Stop from Program menu]

Start:
From Windows start menu, select [Elysium 3DxSUITE WorkerNode] > [Start 3DxSUITE
WorkerNode EX9.1].

Stop:
Press [×] button at the top right of the window to close the command prompt whose name
begins with "3DxSUITE-…"

[Start/Stop from WorkerNode Setting dialog]

Start:
Right-click the node you want to start, and select [Start] from the context menu.

Select [Run as Process] > [Start All].
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When the booting of WorkerNode succeeds, the following window appears.

Stop:
Right-click the node you want to stop, and select [Stop] from the context menu. Select [Run as
Process] > [Stop All].

[Start/Stop from the Command Line Interface]

Start / stop WorkerNodes by using the command line interface.
Execute "<3DxSUITE Installation Folder>\EX9.1\WorkerNode\bin\WorkerLauncher.exe"
specifying arguments as follows. For further information, execute "WorkerLauncher.exe /?."

> WorkerLauncher.exe /?

Below are the command examples to start / stop WorkerNode.

• Starting / Stopping All the WorkerNodes Together
Start:
Specify an argument "/Mode=start" to start all WorkerNodes

> WorkerLauncher.exe /Mode=start

Stop:
Specify an argument "/Mode=stop" to stop all WorkerNodes

> WorkerLauncher.exe /Mode=stop

• Starting / stopping WorkerNode at Specified Port
Start:
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Specify the arguments "/Mode=start" and "/ListenPort={Port number}" to start
WorkerNode using the specified port number only.

> WorkerLauncher.exe /Mode=start /ListenPort={Port number (*)}

Stop:
Specify the arguments "/Mode=stop" and "/ListenPort={Port number}" to stop
WorkerNode using the specified port number only.

> WorkerLauncher.exe /Mode=stop /ListenPort={Port number (*)}

(*) Specify the WorkerNode to start/stop by the port number.
(e.g.) Specify the following arguments to start WorkerNode at port number 59859.

> WorkerLauncher.exe /Mode=start /ListenPort=59859

Start as Windows Service

Use the following procedure to start and stop the service.

a. Start Windows Service

1. From WorkerNode Setting menu, select [Windows Service] > [Run].

2. When "User Account Control" warning dialog appears, click [Yes] to execute.

3. Confirm the displayed dialog which indicates that the service started successfully.

b. Stop Windows Service

1. From WorkerNode Setting menu, select [Windows Service] > [Stop].

2. When "User Account Control" warning dialog appears, click [Yes] to execute.

3. Confirm the displayed dialog which indicates that the service stopped successfully.


WorkerNode can only be started as Windows service if all ports configured to
each node are available. Please note that if any port is used by WorkerNode
started as a normal process or another application, the Windows service will
fail to start

9.4. Uninstallation

9.4.1. Manual Uninstallation

1. From Windows start menu, select [Settings](Gear mark).
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2. Then select [Apps].

3. From the list of applications displayed in "Apps & features", select "Elysium 3DxSUITE EX9.1
- WorkerNode" to uninstall.

9.4.2. Silent Uninstallation

Silent uninstallation can be performed by a command. The installer for the version you are
currently using will be required.

• Example of command

Elysium_3DxSUITE_EX9.1_WorkerNode.exe /s /x /v"/l* \"C:\temp\uninstall.log\"
/qn"

This is a list of command arguments to pass to the installer when executing silent
uninstallation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/x Execute uninstallation. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional

9.5. Notes

9.5.1. User Type to Run WorkerNode

Please ensure to run WorkerNode as a user with administrative privileges.

9.5.2. How to Check the Status of WorkerNode

Run the following command to check the status of corresponding WorkerNode, and it will
return a value as shown below. (Replace <port number> by the actual port number which
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WorkerNode uses.)

• <3DxSUITE Installation Folder>\EX9.1\WorkerNode\bin\check-worker-node-status.bat <port
number>

Return value

• "0" when WorkerNode is running

• "1" when WorkerNode is not running

Examples

a. WorkerNode on port number 59859 is running

>C:\Program Files\ELYSIUM\3DxSUITE\EX9.1\WorkerNode\bin\check-worker-node-
status.bat 59859
>echo %ERRORLEVEL%
>0

b. WorkerNode on port number 59860 is not running

>C:\Program Files\ELYSIUM\3DxSUITE\EX9.1\WorkerNode\bin\check-worker-node-
status.bat 59860
>echo %ERRORLEVEL%
>1

9.5.3. About WorkerNode Logs

Operation logs of WorkerNode is output to the following folder. If there is a problem with the
operation, refer to the log output in this folder to confirm the processing status:

%PUBLIC%\Documents\Elysium\3DxSUITE\Config\WorkerNode\EX9.1\log
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10. Elysium 3DxSUITE ScenarioEditor
Programs that need to be installed in advance

• n/a

10.1. Installation

 You need Administrator privileges to install Elysium products.



Please note that when installing Components by using
"Elysium_3DxSUITE_EX9.1_Components.exe", ScenarioEditor can also be

installed at the same time. If ScenarioEditor is being installed at the
same time as Components, then you do not need to install ScenarioEditor
separately.

10.1.1. Manual Installation

1. Run the installer of ScenarioEditor.

◦ Folder containing the installer: <3DxSUITE Components Package>\ScenarioEditor\

◦ Installer: Elysium_3DxSUITE_EX9.1_ScenarioEditor.exe

2. Select the language for the installation and click [OK].

3. If Setting Utility is not installed, the Setting Utility installer will start. Follow the steps below
to perform the installation. If Setting Utility is already installed, skip to the step after
installing Setting Utility.

a. Select which language to use when installing, and click [OK].

b. If above dialog is displayed, click [Install] to start the installation. If 3DxSUITE Setting
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Utility is already installed, this dialog will not appear.

c. Installation Wizard starts. Click [Next].

d. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.
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e. "Set up Elysium License" dialog will appear. Enter Host name of the computer where you
installed Sentinel RMS License Manager, and if necessary, change Port number. And
then click [Next].

f. "Set up Folders" dialog will appear. Change the folder path if necessary, and then click
[Next].
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g. Click [Install] to start the installation.

h. When the installation of Setting Utility is completed, the following dialog will appear.
Click [Finish] to close the installer.
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i. When a dialog appears prompting you to reboot, then reboot the OS. After the OS has
rebooted, continue with the next step.

4. Install Wizard starts. Click [Next].

5. Select "I accept the terms of the license agreement" if you agree, and then click [Next]. If you
disagree, you cannot continue the installation.

6. The dialog to specify a destination folder will appear. To change the destination folder from
default setting, click [Change] and specify the new destination folder. When the setting is
finished, click [Next].
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7. Disable "Create a desktop shortcut" if you do not want to create a desktop shortcut. Click
[Install] to start the installation.

8. The following dialog will appear when installation is completed. Click [Finish] to close the
installer.
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10.1.2. Silent Installation

By using the command, you can install or upgrade ScenarioEditor without GUI operations.

• Example of command

Elysium_3DxSUITE_EX9.1_ScenarioEditor.exe /s /v"/l* \"C:\temp\install.log\"
INSTALLDIR=\"C:\Program Files\Elysium\3DxSUITE\EX9.1\ScenarioEditor\" /qn"

This is a list of command arguments to pass to the installer when executing silent installation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• INSTALLDIR=\"<Installation Folder>\" : Specify the folder
where you want to install. This can be specified only
when installing.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional
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10.2. Launch
From Windows start menu, select [Elysium 3DxSUITE ScenarioEditor] > [3DxSUITE
ScenarioEditor EX9.1] to launch.



Also, double-click [3DxSUITE ScenarioEditor EX9.1] shortcut on your desktop to
launch.

ScenarioEditor will start.

10.3. Exit
Select [File] > [Exit] from the menu or close the window to exit.
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10.4. Uninstallation

10.4.1. Manual Uninstallation

1. From Windows start menu, select [Start] > [Settings](Gear mark).

2. Then select [Apps].

3. From the list of applications displayed in "Apps & features", select "Elysium 3DxSUITE EX9.1
- ScenarioEditor" to uninstall.

10.4.2. Silent Uninstallation

Silent uninstallation can be performed by a command. The installer for the version you are
currently using will be required.

• Example of command

Elysium_3DxSUITE_EX9.1_ScenarioEditor.exe /s /x /v"/l* \"C:\temp\uninstall.log\"
/qn"

This is a list of command arguments to pass to the installer when executing silent
uninstallation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/x Execute uninstallation. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional
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11. Elysium 3DxSUITE Data Package Studio
Programs that need to be installed in advance

• Adobe Acrobat Pro

11.1. Installation

 You need Administrator privileges to install Elysium products.

11.1.1. Manual Installation

1. Run the installer for Data Package Studio.

◦ Folder containing the installer: <3DxSUITE Data Package Studio Package>\

◦ Installer:

▪ Elysium_3DxSUITE_EX9.1_Data_Package_Studio_for_Acrobat_32bit.exe

▪ Elysium_3DxSUITE_EX9.1_Data_Package_Studio_for_Acrobat_64bit.exe



Data Package Studio installer is available in two types, 64 bit and 34 bit.
Please note that you must run the installer with the same type (32bit/64bit)
as the Adobe Acrobat product installed on your computer. Different types
of Adobe Acrobat products are as follows:

Product Name 32bit/64bit

Adobe Acrobat Pro DC Continuous (Older version) 32bit

Adobe Acrobat Pro 2017 (Classic) 32bit

Adobe Acrobat Pro 2020 (Classic) 32bit

Adobe Acrobat Pro DC Continuous (Latest version) 32bit/64bit

2. Select the language for the installation and click [OK].

3. When this dialog appears, click [Install].
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4. If Setting Utility is not installed, the Setting Utility installer will start. Follow the steps below
to perform the installation. If Setting Utility is already installed, skip to the step after
installing Setting Utility.

a. Select which language to use when installing, and click [OK].

b. If above dialog is displayed, click [Install] to start the installation. If 3DxSUITE Setting
Utility is already installed, this dialog will not appear.

c. Installation Wizard starts. Click [Next].
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d. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.

e. "Set up Elysium License" dialog will appear. Enter Host name of the computer where you
installed Sentinel RMS License Manager, and if necessary, change Port number. And
then click [Next].
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f. "Set up Folders" dialog will appear. Change the folder path if necessary, and then click
[Next].

g. Click [Install] to start the installation.
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h. When the installation of Setting Utility is completed, the following dialog will appear.
Click [Finish] to close the installer.

i. When a dialog appears prompting you to reboot, then reboot the OS. After the OS has
rebooted, continue with the next step.

5. Install Wizard starts. Click [Next].

6. Select "I accept the terms of the license agreement" if you agree, and then click [Next]. If you
disagree, you cannot continue the installation.
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7. The dialog to specify a destination folder (plug_ins) will appear. Click [Change].

8. Specify the destination folder. After specifying, click [OK].
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9. Confirm the destination folder which appears, then click [Next].

10. Click [Install] to start the installation.

11. The following dialog will appear when installation is completed. Click [Finish] to close the
installer.
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11.1.2. Silent Installation

By using the command, you can install Data Package Studio without GUI operations.

• Example of command

Elysium_3DxSUITE_EX9.1_Data_Package_Studio_for_Acrobat_32bit.exe /s
/v"INSTALLDIR=\"C:\Program Files (x86)\Adobe\Acrobat DC\Acrobat\plug_ins\" /qn"

or

Elysium_3DxSUITE_EX9.1_Data_Package_Studio_for_Acrobat_64bit.exe /s
/v"INSTALLDIR=\"C:\Program Files (x86)\Adobe\Acrobat DC\Acrobat\plug_ins\" /qn"

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory
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Command
Argument

Description Mandatory /
Optional

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• INSTALLDIR=\"<Installation Folder>\" : Specify the folder
where you want to install. This can be specified only
when installing.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional

11.2. Launch
1. Launch Adobe Acrobat Pro.

2. Select [Elysium] > [Start Data Package Studio] from the menu.

11.3. Exit
By exiting Adobe Acrobat Pro, Data Package Studio will also end.

11.4. Uninstallation

11.4.1. Manual Uninstallation

1. From Windows start menu, select [Settings](Gear mark).

2. Then select [Apps].

3. From the list of applications displayed in "Apps & features," select one of the following to
uninstall:

◦ Elysium 3DxSUITE EX9.1 - Data Package Studio for Acrobat 32bit

◦ Elysium 3DxSUITE EX9.1 - Data Package Studio for Acrobat 64bit
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11.4.2. Silent Uninstallation

Silent uninstallation can be performed by a command. The installer for the version you are
currently using will be required.

• Example of command

Elysium_3DxSUITE_EX9.1_Data_Package_Studio_for_Acrobat_32bit.exe /s /x /v"/l*
\"C:\temp\uninstall.log\" /qn"

or

Elysium_3DxSUITE_EX9.1_Data_Package_Studio_for_Acrobat_64bit.exe /s /x /v"/l*
\"C:\temp\uninstall.log\" /qn"

This is a list of command arguments to pass to the installer when executing silent
uninstallation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/x Execute uninstallation. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional
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12. Elysium 3DxSUITE Validation
Configurator
Programs that need to be installed in advance

• n/a

12.1. Installation

 You need Administrator privileges to install Elysium products.

12.1.1. Manual Installation

1. Run the installer of Validation Configurator.

◦ Folder containing the installer: <3DxSUITE Validation Configurator Package>\

◦ Installer: Elysium_3DxSUITE_EX9.1_Validation_Configurator.exe

2. Select the language for the installation and click [OK].

3. When this dialog appears, click [Install].
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4. If Elysium 3DxSUITE Ruby is not installed in the environment, Elysium 3DxSUITE Ruby
installer will start. Follow the steps below to perform the installation. If Elysium 3DxSUITE
Ruby is already installed, skip to the step after installing Elysium 3DxSUITE Ruby.

a. Select which language to use when installing, and click [OK].

b. Installation Wizard starts. Click [Next].

c. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.

d. "Destination Folder" dialog will appear. To change the destination folder from default
setting, click [Change] and specify the new destination folder. When the setting is
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finished, click [Next].


Please ensure that the destination folder path consists only of one-byte
alphanumeric characters and several one-byte symbols ("#", "+", "-", "_",
".", "$", "/", ":"). If characters other than these are included in the path,
an error will occur.

e. Click [Install] to start the installation.

f. When installation is completed, the following dialog will appear. Click [Finish] to end the
installer.
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5. If Setting Utility is not installed, the Setting Utility installer will start. Follow the steps below
to perform the installation. If Setting Utility is already installed, skip to the step after
installing Setting Utility.

a. Select which language to use when installing, and click [OK].

b. If above dialog is displayed, click [Install] to start the installation. If 3DxSUITE Setting
Utility is already installed, this dialog will not appear.

c. Installation Wizard starts. Click [Next].
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d. Select "I accept the terms in the license agreement" if you accept the license agreement
and click [Next]. If you don’t accept, you cannot continue the installation.

e. "Set up Elysium License" dialog will appear. Enter Host name of the computer where you
installed Sentinel RMS License Manager, and if necessary, change Port number. And
then click [Next].
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f. "Set up Folders" dialog will appear. Change the folder path if necessary, and then click
[Next].

g. Click [Install] to start the installation.
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h. When the installation of Setting Utility is completed, the following dialog will appear.
Click [Finish] to close the installer.

i. When a dialog appears prompting you to reboot, then reboot the OS. After the OS has
rebooted, continue with the next step.

6. Install Wizard starts. Click [Next].

7. Select "I accept the terms of the license agreement" if you agree, and then click [Next]. If you
disagree, you cannot continue the installation.
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8. The dialog to specify a destination folder will appear. To change the destination folder from
default setting, click [Change] and specify the new destination folder. When the setting is
finished, click [Next].


Please ensure that the destination folder path consists of ASCII characters
only. If the folder path contains non-ASCII characters, the application may
not work as expected.

9. Disable "Create a desktop shortcut" if you do not want to create a desktop shortcut. Click
[Install] to start the installation.
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10. The following dialog will appear when installation is completed. Click [Finish] to close the
installer.

12.1.2. Silent Installation

By using the command, you can install or upgrade Validation Configurator without GUI
operations.

• Example of command (No line breaks required)

Elysium_3DxSUITE_EX9.1_Validation_Configurator.exe /s /v"/l*
\"C:\temp\install.log\" INSTALLDIR=\"C:\Program
Files\Elysium\3DxSUITE\EX9.1\Validation Configurator\" /qn"
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This is a list of command arguments to pass to the installer when executing silent installation.

Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• INSTALLDIR=\"<Installation Folder>\" : Specify the folder
where you want to install. This can be specified only
when installing.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional

12.2. Launch
1. From Windows start menu, select [Elysium 3DxSUITE Validation Configurator] > [3DxSUITE

Validation Configurator EX9.1].



Also, double-click [3DxSUITE Validation Configurator EX9.1] shortcut on
your desktop to launch.

Validation Configurator will start and Main dialog will appear.
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12.3. Exit
Close the window to exit.

12.4. Uninstallation

12.4.1. Manual Uninstallation

1. From Windows start menu, select [Start] > [Settings](Gear mark).

2. Then select [Apps].

3. From the list of applications displayed in "Apps & features", select "Elysium 3DxSUITE EX9.1
- Validation Configurator" to uninstall.

12.4.2. Silent Uninstallation

Silent uninstallation can be performed by a command. The installer for the version you are
currently using will be required.

• Example of command

Elysium_3DxSUITE_EX9.1_Validation_Configurator.exe /s /x /v"/l*
\"C:\temp\uninstall.log\" /qn"

This is a list of command arguments to pass to the installer when executing silent
uninstallation.
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Command
Argument

Description Mandatory /
Optional

/s Execute installation or uninstallation in silent mode. Mandatory

/x Execute uninstallation. Mandatory

/v Specify the following arguments in the form of /v"arg1 arg2
…":

• /l* \"<Log file>\" : Specify the log file path. A space is
required between "/ l *" and the filename.

• /qn : Install or uninstall without displaying the dialog.

• /qn+ : Dialog is displayed when installation or
uninstallation is completed.

Optional
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13. Elysium 3DxSUITE PDQ Checker
Configurator
Programs that need to be installed in advance

• n/a

13.1. Installation
PDQ Checker Configurator installer does not exist. Copy "PDQCheckerSetting_ENG.xlsm"
included in <3DxSUITE PDQ Checker Configurator Package> to any location and use it.

13.2. Launch
Open "PDQCheckerSetting_ENG.xlsm" with Microsoft Excel.

13.3. Exit
Exit Microsoft Excel.

13.4. Uninstallation
Delete "PDQCheckerSetting_ENG.xlsm".
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14. Elysium 3DxSUITE Setting Utility
Programs that need to be installed in advance

• n/a

14.1. Installation
3DxSUITE Setting Utility is automatically installed as needed when you run the installer for
each product. It does not have to be installed separately.

14.2. Launch
From Windows start menu, select [Elysium 3DxSUITE] > [3DxSUITE User Common Setting] or
[Elysium 3DxSUITE] > [3DxSUITE Local User Setting] to launch.

14.3. Exit
Click [OK] at the bottom of the window or close the window to exit.

14.4. Uninstallation
1. In Windows menu, select  [Settings] > [Apps].

2. From the list of apps that appears, select "Elysium 3DxSUITE EX9.1 - Setting Utility".

3. Click [Uninstall].

Elysium 3DxSUITE Installation Guide

 © 2022 Elysium Page 185 | 193



15. Troubleshooting
Case 1: When launching SmartLauncher (Plug-in) for CATIA V5, the contents of CATIA V5
environment file are not reflected.

[Workaround] This may occur when the CATIA V5 environment file is not specified correctly.
Specify the CATIA V5 environment file according to the contents described in Initial Settings for
CAD Systems - CATIA V5.

Case 2: When executing the translation by SmartLauncher (Standalone) from Explorer
context menu, a CATIA V5 licensing error occurs. When starting CATIA V5 by the normal
procedure, no error occurs.

[Workaround] This may occur when the CATIA V5 environment file is not specified correctly.
Follow the steps below to specify the CATIA V5 environment file.

1. From Windows menu, select [Elysium 3DxSUITE] > [3DxSUITE User Common Setting] or
[Elysium 3DxSUITE] > [3DxSUITE Local User Setting].

2. Open [CAD] tab.

3. Select [CATIA V5] tab and click the gear mark of the version to use for translation.

4. Enter the absolute path of CATIA V5 environment file in "CATIAV5_EnvPath" for "CAD2ENF"
and "ENF2CAD", and click [OK].

5. Click [OK] to close [3DxSUITE User Common Setting] or [3DxSUITE Local User Setting]
windows.

Case 3: In the customized NX environment (including Teamcenter environment),
SmartLauncher (Plug-in) for NX menu does not appear.
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[Workaround] Follow the instructions in Initial Settings for CAD Systems - NX to configure the
settings.

Case 4: Cannot find the SmartLauncher (Plug-in) installer for the version of CAD I want to
use.

[Workaround] SmartLauncher (Plug-in) supports only some of the CAD versions supported by
3DxSUITE. Please refer to "Supported CAD Versions" in the Release Note for more details.

Case 5: During silent installation, the Operating System (OS) reboots.

[Workaround] This is the expected behavior, so there is no workaround. In manual installation,
a dialog will appear asking you to reboot when the installation is complete; however, in silent
installation, this dialog will not appear, and the computer will reboot automatically.

Case 6: The completion screen freezes when canceling the execution of
"Elysium_3DxSUITE_EX9.1_Components.exe" in the middle.

[Workaround] Start task manager and terminate the
"Elysium_3DxSUITE_EX9.1_Components.exe" process.

Case 7: "Elysium_3DxSUITE_EX9.1_Components.exe" execution fails.

[Workaround] This may occur when only the installation of
"Elysium_3DxSUITE_EX9.1_Component_Base.exe" is performed. If applicable, perform an
additional installation of "Elysium_3DxSUITE_EX9.1_SmartLauncher_Base.exe", or uninstall
"Elysium 3DxSUITE EX9.1 - Component Base" from Windows "Apps and features".

Case 8: One of the 3DxSUITE products does not start, even though it appears to have been
successfully installed.

[Workaround] This may occur when installing an application on a path including junction
which has been set. Specify a path that does not include a junction during installation. Please
refer to the following URL for more details on junction.
https://docs.microsoft.com/en-us/sysinternals/downloads/junction
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Appendix A: List of 3DxSUITE Installers
Product Name Description

Elysium_3DxSUITE_EX9.1_Viewer.exe

3DxSUITE Viewer Installer for installing 3DxSUITE Viewer.

Elysium_3DxSUITE_EX9.1_Editor.exe

3DxSUITE Editor Installer for installing 3DxSUITE Editor.

Elysium_3DxSUITE_EX9.1_SmartLauncher.exe

3DxSUITE SmartLauncher Installer for installing 3DxSUITE SmartLauncher.

Elysium_3DxSUITE_EX9.1_SmartController.exe

3DxSUITE SmartController Installer for installing 3DxSUITE SmartController.

Elysium_3DxSUITE_EX9.1_SmartController_Pro.exe

3DxSUITE SmartController Pro Installer for installing 3DxSUITE SmartController
Pro.

Elysium_3DxSUITE_EX9.1_TransServer.exe

3DxSUITE TransServer Installer for installing 3DxSUITE TransServer.

Elysium_3DxSUITE_EX9.1_WorkerNode.exe

3DxSUITE WorkerNode Installer for installing 3DxSUITE WorkerNode.

Elysium_3DxSUITE_EX9.1_Components.exe

All products except some This is an installer for batch installation of all
products except for some Front-End and Utility Tool
products.

Elysium_3DxSUITE_EX9.1_Data_Package_Studio.exe

3DxSUITE Data Package Studio Installer for installing 3DxSUITE Data Package
Studio.

Elysium_3DxSUITE_EX9.1_Validation_Configurator.exe

3DxSUITE Validation Configurator Installer for installing 3DxSUITE Validation
Configurator.

Elysium_3DxSUITE_EX9.1_3D_PDF_Adapter.exe

3DxSUITE 3D PDF Adapter Installer for installing 3DxSUITE 3D PDF Adapter.
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Product Name Description

Elysium_3DxSUITE_EX9.1_3DEXPERIENCE_Adapter.exe

3DxSUITE 3DEXPERIENCE Adapter Installer for installing 3DxSUITE 3DEXPERIENCE
Adapter.

Elysium_3DxSUITE_EX9.1_3DXML_Adapter.exe

3DxSUITE 3DXML Adapter Installer for installing 3DxSUITE 3DXML Adapter.

Elysium_3DxSUITE_EX9.1_ACIS_Adapter.exe

3DxSUITE ACIS Adapter Installer for installing 3DxSUITE ACIS Adapter.

Elysium_3DxSUITE_EX9.1_CADmeister_Adapter.exe

3DxSUITE CADmeister Adapter Installer for installing 3DxSUITE CADmeister
Adapter.

Elysium_3DxSUITE_EX9.1_CATIA_V4_Adapter.exe

3DxSUITE CATIA V4 Adapter Installer for installing 3DxSUITE CATIA V4 Adapter.

Elysium_3DxSUITE_EX9.1_CATIA_V5_Adapter.exe

3DxSUITE CATIA V5 Adapter Installer for installing 3DxSUITE CATIA V5(Plug-in)
Adapter.

Elysium_3DxSUITE_EX9.1_CATIA_V5_Standalone_Adapter.exe

3DxSUITE CATIA V5 Standalone
Adapter

Installer for installing 3DxSUITE CATIA
V5(Standalone) Adapter.

Elysium_3DxSUITE_EX9.1_CATIA_V5_XCAD_Adapter.exe

3DxSUITE CATIA V5 XCAD Adapter Installer for installing 3DxSUITE CATIA V5 XCAD
Adapter.

Elysium_3DxSUITE_EX9.1_Component_Base.exe

3DxSUITE Component Base Installer for installing 3DxSUITE Component Base.

Elysium_3DxSUITE_EX9.1_Creo_Elements_Direct_Adapter.exe

3DxSUITE Creo Elements Direct
Adapter

Installer for installing 3DxSUITE Creo Elements
Direct Adapter.

Elysium_3DxSUITE_EX9.1_Creo_Parametric_Adapter.exe

3DxSUITE Creo Parametric Adapter Installer for installing 3DxSUITE Creo
Parametric(Plug-in) Adapter.
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Product Name Description

Elysium_3DxSUITE_EX9.1_Creo_Parametric_Standalone_Adapter.exe

3DxSUITE Creo Parametric Standalone
Adapter

Installer for installing 3DxSUITE Creo
Parametric(Standalone) Adapter.

Elysium_3DxSUITE_EX9.1_Creo_View_Adapter.exe

3DxSUITE Creo View Adapter Installer for installing 3DxSUITE Creo View Adapter.

Elysium_3DxSUITE_EX9.1_iCAD_Adapter.exe

3DxSUITE iCAD Adapter Installer for installing 3DxSUITE iCAD Adapter.

Elysium_3DxSUITE_EX9.1_IGES_Adapter.exe

3DxSUITE IGES Adapter Installer for installing 3DxSUITE IGES Adapter.

Elysium_3DxSUITE_EX9.1_Inventor_Adapter.exe

3DxSUITE Inventor Adapter Installer for installing 3DxSUITE Inventor Adapter.

Elysium_3DxSUITE_EX9.1_JT_Adapter.exe

3DxSUITE JT Adapter Installer for installing 3DxSUITE JT Adapter.

Elysium_3DxSUITE_EX9.1_Nastran_Adapter.exe

3DxSUITE Nastran Adapter Installer for installing 3DxSUITE Nastran Adapter.

Elysium_3DxSUITE_EX9.1_NX_Adapter.exe

3DxSUITE NX Adapter Installer for installing 3DxSUITE NX(Plug-in)
Adapter.

Elysium_3DxSUITE_EX9.1_NX_I-deas_Adapter.exe

3DxSUITE NX I-deas Adapter Installer for installing 3DxSUITE NX I-deas Adapter.

Elysium_3DxSUITE_EX9.1_NX_Standalone_Adapter.exe

3DxSUITE NX Standalone Adapter Installer for installing 3DxSUITE NX(Standalone)
Adapter.

Elysium_3DxSUITE_EX9.1_OBJ_Adapter.exe

3DxSUITE OBJ Adapter Installer for installing 3DxSUITE OBJ Adapter.

Elysium_3DxSUITE_EX9.1_Parasolid_Adapter.exe

3DxSUITE Parasolid Adapter Installer for installing 3DxSUITE Parasolid Adapter.
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Product Name Description

Elysium_3DxSUITE_EX9.1_PLM_XML_Adapter.exe

3DxSUITE PLM XML Adapter Installer for installing 3DxSUITE PLM XML Adapter.

Elysium_3DxSUITE_EX9.1_Point_Cloud_Adapter.exe

3DxSUITE Point Cloud Adapter Installer for installing 3DxSUITE Point Cloud
Adapter.

Elysium_3DxSUITE_EX9.1_QIF_Adapter.exe

3DxSUITE QIF Adapter Installer for installing 3DxSUITE QIF Adapter.

Elysium_3DxSUITE_EX9.1_SmartLauncher_3DEXPERIENCE.exe

3DxSUITE SmartLauncher Plug-in for
3DEXPERIENCE

Installer for installing 3DxSUITE SmartLauncher
Plug-in for 3DEXPERIENCE.

Elysium_3DxSUITE_EX9.1_SmartLauncher_Base.exe

3DxSUITE SmartLauncher Base Installer for installing 3DxSUITE SmartLauncher
Base.

Elysium_3DxSUITE_EX9.1_SmartLauncher_CATIA_V5.exe

3DxSUITE SmartLauncher Plug-in for
CATIA V5

Installer for installing 3DxSUITE SmartLauncher
Plug-in for CATIA V5.

Elysium_3DxSUITE_EX9.1_SmartLauncher_Creo_Parametric.exe

3DxSUITE SmartLauncher Plug-in for
Creo Parametric

Installer for installing 3DxSUITE SmartLauncher
Plug-in for Creo Parametric.

Elysium_3DxSUITE_EX9.1_SmartLauncher_NX.exe

3DxSUITE SmartLauncher Plug-in for
NX

Installer for installing 3DxSUITE SmartLauncher
Plug-in for NX.

Elysium_3DxSUITE_EX9.1_SmartLauncher_SOLIDWORKS.exe

3DxSUITE SmartLauncher Plug-in for
SOLIDWORKS

Installer for installing 3DxSUITE SmartLauncher
Plug-in for SOLIDWORKS.

Elysium_3DxSUITE_EX9.1_SOLIDWORKS_Adapter.exe

3DxSUITE SOLIDWORKS Adapter Installer for installing 3DxSUITE SOLIDWORKS
Adapter.

Elysium_3DxSUITE_EX9.1_SolidEdge_Adapter.exe

3DxSUITE Solid Edge Adapter Installer for installing 3DxSUITE Solid Edge Adapter.
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Product Name Description

Elysium_3DxSUITE_EX9.1_STEP_Adapter.exe

3DxSUITE STEP Adapter Installer for installing 3DxSUITE STEP Adapter.

Elysium_3DxSUITE_EX9.1_STEP_BOM_Adapter.exe

3DxSUITE STEP BOM Adapter Installer for installing 3DxSUITE STEP BOM Adapter.

Elysium_3DxSUITE_EX9.1_STL_Adapter.exe

3DxSUITE STL Adapter Installer for installing 3DxSUITE STL Adapter.

Elysium_3DxSUITE_EX9.1_VRML_Adapter.exe

3DxSUITE VRML Adapter Installer for installing 3DxSUITE VRML Adapter.

Elysium_3DxSUITE_EX9.1_XPDMXML_Adapter.exe

3DxSUITE XPDMXML Adapter Installer for installing 3DxSUITE XPDMXML
Adapter.

Elysium_3DxSUITE_EX9.1_XVL_Adapter.exe

3DxSUITE XVL Adapter Installer for installing 3DxSUITE XVL Adapter.
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